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ВВЕДЕНИЕ

Благодарим Вас за приобретение нашего приемника. Материалы, представленные в данном
руководстве пользователя (далее “Руководство”), были подготовлены фирмой “JAVAD
GNSS” для своих покупателей. Данное Руководство создано в помощь пользователям
нашего продукта. 
Примечание: Пожалуйста, прочтите внимательно нижеприведенные условия и положения.

ИСПОЛЬЗОВАНИЕ  -  Приемники ,  созданные  компанией  “ JAVAD GNSS” ,
разрабатывались для профессионального использования. Предполагается, что пользователь
обладает достаточными знаниями и осведомлен о технике безопасности и правилах работы
с приемником. Всегда следует использовать специальную одежду (защитные ботинки,
каску и т.п.).

АВТОРСКОЕ  ПРАВО  -  Никакая  часть  данного  руководства  не  может  быть
воспроизведена, передана, переписана, не может храниться в системах информационного
доступа, переводиться на другие языки, независимо от форм и целей, без явно
выраженного письменного разрешения компании JAVAD GNSS, за исключением копии,
хранимой покупателем в резервных целях. 

Компания JAVAD GNSS оставляет за собой право вносить изменения в данную
документацию без предварительного уведомления. JAVAD GNSS предоставляет это
Руководство “как есть”, без обязательств любого характера, ни явно выраженных, ни
подразумеваемых, включая, но не ограничиваясь, подразумеваемое обязательство, или
условие выгодности, или пригодность для какой бы то ни было цели. 

ТОРГОВЫЕ МАРКИ - TRIUMPH-1™, JAVAD GNSS® являются торговыми марками
компании JAVAD GNSS, Inc. Windows, Windows 95, Windows 98, Windows 2000, Windows
Me и Windows NT являются торговыми марками корпорации Microsoft®. Bluetooth®

является торговой маркой компании Bluetooth SIG, Inc. Все прочие изделия и торговые
марки, упоминаемые в данном руководстве, принадлежат их законным владельцам. 

ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ - Использование компьютерных программ и
программного обеспечения, выпущенных компанией JAVAD GNSS или скачанных с веб-
сайта компании JAVAD GNSS, в соединении с приемником TRIUMPH-1 подтверждает
принятие условий и положений, приведенных в данном Руководстве, и означает следование
им .  Лицензионное  программное  обеспечение  и  данное  Руководство ,  являясь
9



Введение
О данном руководстве
собственностью компании JAVAD GNSS, защищены законами США о защите авторских
прав и международными соглашениями. Компания JAVAD GNSS предоставляет право:
- Использовать программы на отдельной машине.
-Производить резервное копирование программ при использовании вами отдельной
программы на отдельной машине.
- Установить программы другому лицу, если это лицо согласно принять сроки и условия
Соглашения и вы не оставите копий программ, ни в печатном, ни в доступном с машины,
ни в соединенной с другой программой форме. За исключением того, что четко
предусмотрено лицензией, вы не можете копировать, вносить изменения и переставлять
эти  программы .  ЗАПРЕЩАЕТСЯ  МОДИФИЦИРОВАТЬ ,  ПЕРЕВОДИТЬ ,
ДИЗАССЕМБЛИРОВАТЬ ИЛИ ДЕКОМПИЛИРОВАТЬ ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ
И РУКОВОДСТВО ИЛИ ЛЮБУЮ КОПИЮ, В ЦЕЛОМ ИЛИ ЧАСТИЧНО.

Лицензия действительна до завершения ее срока. Вы можете завершить лицензию в любое
время, ликвидируя приемник, программы и Руководство и все их копии. Компания JAVAD
GNSS может также прервать вашу лицензию, если вы не будете следовать этому
Соглашению. 

КОНФИДЕНЦИАЛЬНОСТЬ - Данное Руководство, его содержание и программное
обеспечение (в целом, “Конфиденциальная информация”) являются конфиденциальной и
собственной информацией компании JAVAD GNSS. 

ПРОЧЕЕ - Изложенные выше условия и положения могут быть исправлены, дополнены
или удалены в любое время по решению компании JAVAD GNSS. Вышеприведенные
условия и положения написаны в соответствии с законами штата Калифорния, США и не
противоречат им.

Электронные версии руководств пользователя, а также информацию о выпуске новых
версий можно найти на сайте JAVAD GNSS: http://www.javad.com. 

Кроме того, эту информацию можно получить по электронной почте по адресу:
support@javad.com. 

О данном руководстве
Данное Руководство расскажет, как работать с приемником TRIUMPH-1: как настроить
различные его компоненты для того или иного вида работы, как проводить съемку с
помощью приемника, как пользоваться приемником и т.д.
10



Введение

Условные обозначения и терминология
Условные обозначения и терминология

В данном руководстве приняты следующие обозначения и термины:

Пример Текст с подобным форматированием применяется при
описании приемника и его компонентов.

Главное Курсивом в тексте выделены названия, заголовки диалоговых
окон ПО, названия пунктов меню, названия компонентов ПО, а
именно: зависимые кнопки, переключатели, закладки и т.п.

Temp Подобным образом отформатированным текстом выделяются в
руководстве строки, которые необходимо ввести в активные
поля ПО и т.п. (например, имя файла или каталога).

Перечень условных обозначений и сокращений

ARP Подантенная точка
CMR Формат поправок, передаваемых с ККС на НАП в

дифференциальном режиме
C/A Сигнал грубого дальномерного кода
DGPS Кодовый дифференциальный режим местоопределения
MinPad панель минимального интерфейса приемника
P Сигнал точного дальномерного кода
RTCM Формат поправок, передаваемых с ККС на НАП в

дифференциальном режиме
RTK Фазовый дифференциальный режим местоопределения

подвижных обьектов в режиме реального времени
ККС Контрольно-корректирующая станция (Base)
НАП Навигационная аппаратура потребителя (Rover)
НИСЗ Навигационный Искусственный Спутник Земли
ПК Персональный Компьютер
ПО Программное Обеспечение
Приемник Спутниковый Радионавигационный Приемник, выпускаемый

компанией JAVAD GNSS
ПСП Псевдослучайная Последовательность
СКО Средняя Квадратическая Ошибка
СРНС Спутниковая Радионавигационная Система (GNSS)
ССЗ  Система Слежения за Задержкой (DLL)
ССН Система Слежения за Несущей (PLL)
ФАПЧ Фазовая АвтоПодстройка Частоты



Введение

Иллюстрации
Иллюстрации

Данное Руководство содержит множество иллюстраций, являющихся, так называемым,
“захватом экрана”. Реальный вид Вашего экрана и окошек может немного отличаться от
вариантов, представленных в Руководстве. Эти отличия несущественные и не должны быть
поводом для беспокойства.

Техническая поддержка

Если у вас возникла проблема и вы не можете найти необходимую информацию в
документации к данному продукту, то обратитесь за помощью к вашему дилеру. Так же
можно обратиться в службу технической поддержки компании JAVAD GNSS на нашем
сайте: www.javad.com.
12



Глава 1
ПРЕДИСЛОВИЕ 

Приемник TRIUMPH-1, основанный на чипе TRIUMPH, - это единый комплекс, готовый к
работе, с ценой качеством, каких вы еще не встречали.

В элегантном, прочном, легком (1,7 кг, 17х17 см) и герметичном корпусе располагаются
ГНСС электроника, модемы, антенны, а также аккумуляторы, обеспечивающие
непрерывную работу прибора до 20 часов, и усовершенствованная система управления
питанием. Батареи, расположены вблизи электроники, что позволяет им лучше работать в
холодную погоду. Батареи можно заряжать от любого источника питания с напряжением от
+10 до +30 В.

Все имеющиеся антенны (ГНСС, УВЧ, GSM, Bluetooth® и Wi-Fi) удачно интегрированны и
защищены. Прибор имеет встроенную ГНСС антенну, но также можно подключать
внешнюю. Внутри корпуса расположены две переключаемые SIM-карты. Благодаря
маленькой герметичной дверце, одну из них можно легко вынимать и менять (Рисунок 1-
1). 

Рисунок 1�1. Приемник TRIUMPH�1 

Приемник TRIUMPH-1 может принимать и обрабатывать сигналы GPS L2C, GPS L5,
ГЛОНАСС C/A L2, и GALILEO, повышая точность измерения координат ваших точек и
позиций. 

Многосистемность приемника TRIUMPH-1 подразумевает возможность одновременного
использования спутников GPS (Global Positioning System) Соединенных Штатов Америки,



Предисловие
ГЛОНАСС (ГЛОбальная Навигационная Спутниковая Система) Российской Федерации и
Galileo (новый европейский проект системы спутниковой навигации Galileo Industries).
Использование большего числа спутников способствует повышению точности измерения
координат, увеличению производительности и снижению стоимости измерительных работ.

Способность работать с двумя частотами и прием сигналов СРНС - эти возможности
приемника TRIUMPH-1 в совокупности позволяют существенно сократить время
получения фиксированного решения в режиме “кинематики реального времени” (RTK,
Real Time Kinematic), широко используемом для получения высокоточных данных.
Множество прочих возможностей приемника, включая методы подавления многолучевости
(multipath reduction) и совместного слежения (common tracking), позволяют устойчиво
принимать слабые сигналы. 

Приемник TRIUMPH-1 обеспечивает пользователя функциональными средствами,
точностью и целостностью, необходимыми для быстрого и простого сбора данных.

После того  как питание  включено и приемник  выполнил самопроверку, двести
шестнадцать каналов приемника инициализируются и начинают отслеживать видимые
СРНС спутники. Каждый канал приемника может использоваться для отслеживания C/A-
L1, P-L1 или P-L2 сигналов. Число доступных каналов позволяет приемнику отслеживать
все видимые спутники в любое время и в любом месте. Антенна принимает различные
сигналы для обработки.

Встроенная антенна, оснащенная малошумящим усилителем (LNA) и радиочастотное
устройство приемника соединены коаксиальным кабелем. Принятый широкополосный
сигнал преобразуется, фильтруется, оцифровывается и распределяется по различным
каналам. Процессор приемника контролирует процесс отслеживания сигнала.

После того, как в канале устанавливается режим слежения за сигналом, осуществляется
измерение необходимых параметров принимаемого сигнала (фаза несущей и задержка
кода). Сигнал демодулируется и из навигационного кадра извлекаются навигационные
данные.

При слежении за сигналами от четырех или более спутников решается задача “абсолютного
местоопределения” и  вычисляются  координаты  приемника  (в системе базовых
геодезических параметров WGS-84 или в другой системе) и время. При необходимости,
информация сохраняется в памяти приемника, и позднее может быть переписана в
компьютер и использована в программах постобработки.

Если приемник работает в RTK-режиме, то сырые данные могут записываться во
внутреннюю память приемника, что обеспечивает оператору возможность дополнительной
проверки результатов измерений, полученных в реальном времени в полевых условиях.



Предисловие
Первое знакомство

Приемник TRIUMPH�1
В  зависимости  от  выбранных  вами  опций ,  приемник  может  иметь  следующие
возможности:

• Режим совместного слежение за сигналами нескольких спутников (Common
Tracking);

• Режим подавления многолучевости (Multipath Reduction);
• Использование сигналов широкозонных систем спутниковой дифференциальной
навигации (SBAS) (WAAS, EGNOS, и т.д.)

• Регулируемые параметры системы фазовой автоподстройки частоты и системы
автоматической подстройки по задержке;

• Типы измерений: двухчастотный статический, кинематический, в режиме
“кинематики реального времени” (RTK) и дифференциальный режим (DGPS); 

• Автоматическая регистрация данных; 
• Установка различных углов;
• Установка различных параметров съемки; 
• Статический или динамический режим.

1.1. Первое знакомство

Приемник TRIUMPH-1 - это 216-канальный приемник со встроенными аккумуляторными
батареями,  с двумя портами для обмена данными, с минимальным пользовательским
интерфейсом (MinPad), со встроенным радиомодемом и беспроводной технологией
Bluetooth®.  

1.1.1. Приемник TRIUMPH�1

Современный дизайн приемника позволяет уменьшить количество кабелей, соединяющих
различные элементы системы, облегчая и делая эффективнее процесс геодезической
съемки. В компактном и надежном корпусе расположены две аккумулятрные батареи, два
слота для SIM-карт, модуль беспроводной технологии Bluetooth®, многосистемная плата
приемника  и  радиомодем .  TRIUMPH-1 может  быть  представлен  в  следующих
конфигурациях:

• с УВЧ модемом;
• c GSM модулем;
• с УВЧ модемом и GSM модулем;
• без  УВМ модема и GSM модуля.



MinPad

MinPad - это минимальный пользовательский интерфейс, используемый для отображения и
управления потоком входящих/исходящих данных  (Рисунок 1-2).

Рисунок 1�2. Минимальный пользовательский интерфейс MinPad

Цвет индикатора состояния батареи BAT (battery) пoказывает уровень зарядки встроенных
аккумуляторных батарей приемника TRIUMH-1.

• Зеленый – более 90% зарядки.
• Желтый – средний уровень зарядки.
• Красный – менее 10% зярядки.
• Не горит – приемник находится в режиме Zero Power, или встроенные батареи
полностью разряжены, а внешний источник питания не подсоединен.

• Быстро мигает – батареи заряжаются
• Медленно мигает – приемник находится в спящем режиме.

Цвет индикатора BT (Bluetooth  отображает уровень активности модуля Bluetooth®б
установленна ли связь с ним и т.п.

• Зеленый –  Bluetooth® включен и связь установлена.
• Желтый – Bluetooth® включен, связь устанавливается.
• Красный – связь не установлена.
• Не горит – Bluetooth® не активен.

Индикатор MOD (modem) LED  показывает состояние модема. 

• Зеленый – УВЧ модем/GSM модуль включен и связь установлена.
• Желтый – плохие условия связи.
• Красный – связь не установлена.
• Не горит – УВЧ модем/GSM модуль не активен.
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Индикатор SAT (satellites) показывает число отслеживаемых спутников.

• Зеленый – восемь и более спутников.
• Желтый – от пяти до семи спутников.
• Красный – менее пяти спутников.
• Не горит – нет спутников.

Эффективное число спутников - это общее чисор спутников мминус количество
отслеживаемых не GPS систем. Например, если отслеживается 8 GPS и 5 ГЛОНАСС
спутников, то эффективное число спутников составляет 12.

Индикатор POS (position) показывает определение позиции для текущего вида съемки.

• Зеленый – Fixed/Diff.
• Желтый – Float/No-Diff. 
• Красный – Позиция не определена.
• Не горит – Приемник выключен.

Индикатор REC (record)отображает статус записи данных и вспыхивает каждый раз, когда
происходит запись данных в файл. 

• Зеленый – запись.
• Желтый – памяти осталось на 10 мин.
• Красный – память заполнена.
• Не горит – не активна.

Кнопка Вкл.Выкл (питание) включает/выключает приемник.

Нажатие кнопки FN (function) включает/останавливает запись данных. Удерживание
кнопки FN при ажатой внопке Вкл/Выкл от 4 до 8 секунд  (индикаторы мигают желтым)
приводит к очистке энергонезависимого ОЗУ (NVRAM).Удерживание кнопки FN при
нажатой кнопке Вкл/Выкл более 30 секунд приводит к перезагрузке приемника.

Слот SIM�карты

Благодаря специальному слоту SIM-карту можно вставлять в приемник и вынимать из него.
После того, как SIM-карта установлена, задействовуется GSM сервис. Как правило, после
установки SIM-карта находится постоянно в приемнике. GSM модуль может быть настроен
с помощью программного обеспечения  компании JAVAD GNSS ModemVU. SIM-карта
покупается отдельно у поставщика услуг сотовой связи.



Кабели
Порты данных и порт питания

У приемника TRIUMPH-1 имеются следующие порты (Рисунок 1-3 на стр. 18): 

• Питание – с красным ободом: используется для подключения приемника ко
внешнему источнику питания. Этот порт может использоваться для зарядки
батарей. Цвет коннектора соответствующего кабеля - красный.

• Последовательные порты А и В – с зеленыи ободом: используются для
установления связи между приемником и внешним устройством. Цвет коннектора
соответствующего кабеля - зеленый.

• Ethernet - с серым ободом: используется для подключения приемника к локальной
сети. Цвет коннектора соответствующего кабеля - серый.

• USB – с черным ободом: используется для высокоскоростной передачи данных и
связи  между  приемником  и  внешним  устройством .  Цвет  коннектора
соответствующшего кабеля - черный.

Рисунок 1�3. Порты приемника TRIUMPH�1

Разъем внешней ГНСС антенны

К приемнику можно подключить внешнюю ГНСС антенну с помощью TNC разъема для
внешней ГНСС антенны.

Крепление

Стандартная  5/8-11'' резьба крепления приемника на вешке или адапторе.

1.1.2. Кабели

Стандартные кабели, входящие в комплект поставки приемника TRIUMPH-1, включают в
себя кабель питания и кабель связи, которые используются для питания приемника и
зарядки встроенных батарей и для настройки приемника. Ниже представлены стандартные
кабели для приемника:



Предисловие
Файл авторизации опций (OAF)

Прочие принадлежности
• Кабель питания соединяет порт питания приемника с разъемом блока питания для
питания приемника и зарядки батарей. Цвет разъема красный.

• Кабель для последовательного соединения соединяет приемник и внешнее
устройство (контроллер или компьютер) для настройки приемника и передачи
данных. Цвет разъема зеленый.

• USB кабель для соединения приемника с внешним устройством и внешнего
устройства (контроллера или компьютера) через USB-порт. Цвет коннектора
черный.

1.1.3. Прочие принадлежности

Зарядное устройство заряжает встроенные батареи, если само оно подсоединено к сети.
Это устройство преображает переменный ток сети в постоянный ток, необходимый для
зарядки батарей и/или питания приемника. 

1.1.4. Литература

С приемником поставляется следующая литература, которую также можно найти на сайте
компании JAVAD GNSS (http://www.javad.com):

• TRIUMPH-1. Руководство пользователя
• TRIUMPH-1. Быстрый старт
• Тенические спецификации

1.2. Файл авторизации опций (OAF)

Компания JAVAD GNSS выпускает файл авторизации опций (Option Authorization File
(OAF)), чтобы активировать специальные опции, которые покупает пользователь. Файл
авторизации опций позволяет пользователю настроить приемник TRIUMPH-1 согласно
частным практическим задачам в соответствии с приобретенным набором необходимых
опций.

Обычно, все приемники TRIUMPH-1 имеют временный файл авторизации опций (OAF),
что дает возможность использовать приемник на определенное время. Когда приемник
куплен, желательно загрузить новый файл авторизации опций (OAF), с приобретенными
постоянными опциями. Опции приемника сохраняются неповрежденными и неизменными
при очистке энергонезависимого оперативного запоминающего устройства (ОЗУ) или при
операции аппаратного сброса.



Предисловие

Литература
Файл авторизации опций (OAF) позволяет активировать следующие функции приемника:

• Тип сигнала (стандартный L1; дополнительно L2)
• Память (стандартная 0 MB)
• Частота обновления (стандартная 1 Гц; дополнительно 5, 10 или 20 Гц)
• RTK на 1 Гц, 5 Гц, 10 Гц и 20 Гц
• RTCM/CMR Input/Output
• Маркер событий 
• Совместное слежение за навигационными сигналами
• Повышенное подавление многолучевости
• Широкозонная система спутниковой дифференциальной навигации (Wide Area

Augmentation System (WAAS) и European Geostationary Navigation Overlay Service
(EGNOS))

• Автоматическое обнаружение и отбраковка аномальных измерений Receiver
Autonomous Integrity Monitoring (RAIM)

• 1 PPS (Pulse-Per-Second; a timing signal)



Глава 2
ДОСЪЕМОЧНАЯ  НАСТРОЙКА

Прежде, чем вы начнете съемку с использованием приемника TRIUMPH-1, необходимо
установить следующее программное обеспечение и произвести нижеприведенные
настройки: 

• Установить программное обеспечение для конфигурации приемника. См.
“Установка программного обеспечения.” на стр. 21.

• Опционально: SIM-карта. См. “Установка опциональной SIM-карты” на стр. 22.
• Зарядить батареи. См. “Зарядка батарей” на стр. 23.
• Активировать настройки питания. См. “Управление питанием” на стр. 24.
• Настроить модуль Bluetooth. См. “Настройка Bluetooth®-модуля” на стр. 31.
• Собрать альманах. См. “Сбор альманаха” на стр. 33.

2.1. Установка программного обеспечения.

2.1.1. Установка TriVU

Программное обеспечение TriVUTM, работающее в ОС Windows NT/2000/XP/WM,
предназначено для управления спутниковыми радионавигационными приемниками,
выпускаемыми компанией JAVAD GNSS, с использованием ПК, контроллера Victor или
других бытовых наладонных контроллеров. Последнюю версию программы можно найти
на сайте компании JAVAD GNSS: www.javad.com.

Настоящая версия TriVU не имеет автоматически запускаемой программы установки,
поэтому установка выполняется вручную. Скопируйте каталог с программой на жесткий
диск вашего ПК (на карту памяти вашего контроллера), выберите исполняемый файл
TriVU.exe и запустите программу двойным щелчком.

Чтобы удалить программу с компьютера, выделите весь каталог программы и нажмите
Delete.
Примечание: Полное описание программного обеспечения TriVU выходит за рамки этого описания, но вся

необходимая информация содержится в руководстве пользователя TriVU Software Manual.
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Установка опциональной SIM�карты
Установка ModemVU
2.1.2. Установка ModemVU

Программное обеспечение ModemVUTM,  работающее в ОС Windows NT/2000/XP,
предназначено для управления встроенного радиомодема приемника TRIUMPH-1.
Последнюю версию программы можно найти на сайте компании  JAVAD GNSS:
www.javad.com.
Примечание: За подробным описанием программы ModemVU обращайтесь к ModemVU Software Manual.

1. Если программа была скачана с сайта, то сохраните каталог программы на жестком
диске вашего ПК.

2. В каталоге программы найдите и дважды щелкните по иконке файла Setup.exe. 
3. Следуйте инструкциям мастера установки программ. Используйте кнопки: Next для

продолжения устаноки, Back для возвращения на шаг назад, Cancel для прерывания
процесса установки.

4. Выберите место, куда будет устанавливаться программа или оставьте установки по
умолчанию. 

5. Нажмите Finish для завершения процесса установки.
6. При желании можно саздать ярлык на рабочем столе компьютера для быстрого

доступа к ModemVU.

Чтобы удалить программу с компьютера используйте кнопку Start:

1. В каталоге программы найдите и дважды щелкните по иконке файла Setup.exe. 
2. Следуйте инструкциям мастера установки/удаления программ.

2.2. Установка опциональной SIM�карты

SIM-карта позволяет установить телефонную связь для передачи данных между двумя
приемниками, приспособленными для работы со стандартом GSM. SIM-карта покупается
отдельно у местного поставщика сотовых услуг. После установки, карта, как правило,
остается в приемнике. SIM-карта должна поддерживать Circuit Switched Data для
установления прямой связи между приемниками. SIM-карта должна поддерживать GPRS
для работы с IP адресом GPS сети.
Примечание: И стационарный приемник, работающий как база, и подвижный применик должны иметь

установленную SIM-карту (с поддержкой Circuit Switched Data) и для лучшей работы иметь
подписку у одного и того же поставщика сотовой связи.

Для того, чтобы установить SIM-карту:

1. Убедитесь, что приемник выключен.



Досъемочная настройка
Зарядка батарей

Требования к источнику питания
2. Откройте дверцу SIM-карты.
3. Осторожно вложите SIM-карту в слот.

Рисунок 2�1. Установка SIM�карты

Когда приемник будет включен, плата приемника опознает SIM-карту, и она будет готова к
использованию.

2.3. Зарядка батарей

Прежде, чем начать работу, зарядите полностью аккумуляторные батареи. Для полного
цикла зарядки необходимо около 6-ти часов. Обе батареи заряжаются одновременно.
Батареи защищены от перезарядки.  
Примечание: С завода отпускаются незаряженные батареи. Полностью зарядите батареи перед съемкой.

Ионно-литиевые аккумуляторные батареи, используемые в приемнике, сохраняют не менее
98% емкости после 500 циклов зарядки. Эти батареи не требуют полной разрядки для
подзарядки.

2.3.1. Требования к источнику питания

Приемник TRIUMPH-1 можно подключить к внешнему источнику питания с помощью
кабеля с  5-ти штырьковым ODU-разъемом или с SAE-разъемом. Если внешний источник
питания имеет только SAE-разъем, то нужен дополнительно кабель типа приемник-SAE.
Рекомендуется использовать внешний источник питания типа Limited Power Source,
который  должен быть сертифицирован для использования в США и странах Европейского
содружества.

Номинальное напряжение внешнего источника питания может быть в пределах от 10 до 30
В . Внешний  источник должен иметь  достаточную  выходную мощность,  чтобы
обеспечивать величину постоянного тока не менее 5 A. 

Tребования к внешнему источнику питания для других продуктов компании JAVAD GNSS
могут достаточно сильно отличаться.



Досъемочная настройка
ОСТОРОЖНО! Чтобы избежать опасности повреждения при подключении, прежде, чем подключить
оборудование к источнику питания, убедитесь, что источник питания соответствует
местным и национальным требованиям безопасности и соответствует требуемому
напряжению оборудования и данным условиям.

ОСТОРОЖНО! Никогда не чистите включенный в сеть источник питания. Всегда отсоединяйте его от
источника переменного тока, прежде чем начать обслуживание или чистку.

Внимание: Если подаваемое напряжение ниже обозначенного в спецификации приемника, то приемник не
будет работать. Если подаваемое напряжение выше обозначенного в спецификации
максимально допустимого, то приемник может быть серьезно поврежден, а гарантия
прервана.

Убедитесь, что провода не перекручены, не спутаны между собой и не подвергаются
нагрузке. 

Не используйте оборудование с поврежденными проводами или штекерами – заменяйте их
немедленно. Чтобы снизить риск повреждения оборудования, когда отсоединяете провода
от оборудования, тяните за штекер, а не за провод.

Не используйте источник питания, если он оплавлен, разбит или еще как-либо поврежден.
Не разбирайте источник питания. 
Внимание: Прежде чем подсоединять внешний источник питания к приемнику, убедитесь, что его

технические характеристики и состояние соответствуют требуемым и описанным выше.
Примечание: Если приемник использует внешние батареи, как основной источник питания, убедитесь, что режим

зарядки установлен в положение Off (выключен). В противном случае, внешние батареи будут
заряжать встроенные аккумуляторные батареи, снижая тем самым собственное время работы. См.
“Управление питанием”  для полученя более подробной информации о настройках режима зарядки. 

2.4. Управление питанием

Настройка приемника выполняется с помощью программы TriVU. 

1. Соедините приемник с ПК. См. подробнее “Соединение приемника и компьютера”
на стр. 29.

2. Запустите на ПК TriVU. Выберите порт, к которому подключен примник (Рисунок
2-2 на стр. 25)
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:

Рисунок 2�2. Подключение

3. После установления связи выберите пункт меню Configuration и подменю Receiver
или воспользуйтесь горячими клавишами Ctrl+V (Рисунок 2-3):

Рисунок 2�3. Configuration �>Receiver
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4. Откройте закладку General (Рисунок 2-4): 

Рисунок 2�4. Закладка General

5. В закладке General в самораскрывающемся списке Power выберите необходимый
источник питания (Рисунок 2-5): 

Рисунок 2�5.  Power mode

• Auto – приемник автоматически выбирает источник, из которого будет поступать
питание;

• Mix – приемник автоматически выбирает и начинает использовать источник
питания, обладающий наибольшим напряжением; 

• Battery A – приемник использует батарею A; 
• Battery B – приемник использует батарею B; 
• External – приемник использует внешний источник питания.
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6. В раскрывающемся списке Mode поля Charger можно задать режим зарядки
батарей (Рисунок 2-6): 

Рисунок 2�6. Charger�Mode

• Off – приемник не производит зарядки батарей; 
• Charge A – приемник заряжает батарею A; 
• Charge B – приемник заряжает батарею B; 
• Auto – приемник автоматически определяет наличие батарей и заряжает их. 

7. Раскрывающийся список Ports поля Power output modes управляет подачей питания
на последовательные порты приемника:

• On – плата питния будет подавать питание на все порты, когда приемник включен.
Питание будет отсутствовать, когда приемник выключен.

• Off – питание портов отсутствует, даже если приемник включен.
• Always – плата питания будет подавать питание на все порты даже если приемник
выключен.
Используя настройку Slots поля Power output modes, можно управлять подачей
питания на внутренние слоты приемника 

• On – на все слоты подается питание, когда приемник включен. Питание будет
отсутствовать, когда приемник выключен.

• Off – подача питания на слоты выключена, даже если приемник включен.
• Always – подача питания на слоты будет осуществляться, даже если приемник будет
выключен. 

8. В поле Voltages можно просмотреть информацию о напряжении внешнего
источника, батарей и т.п. (Рисунок 2-7).

Рисунок 2�7. Voltages Information
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Включение/Выключение приемника
• Поле External показывает пользователю напряжение внешнего источника питания. 
• В поле On Board отражается истинное напряжение питания платы приемника.
• Поля Battery A и Battery B показывают напряжение батарей A и B соответственно. 
• Поле Charger показывает выходное напряжение зарядного устройства в момент
зарядки батареи. 

9. Переключатели Slot 2, Slot 3 и Slot 4 включают соответствующие слоты. 
10. Нажмите Apply.

2.5. Питание приемника

Зарядное устройство, используемое для зарядки встроенных аккумуляторных батарей,
можно использовать в качестве внешнего источника (питания) постоянного тока. Зарядное
устройство входит в стандартную комплектацию приемника.

• Подсоедините к разъему питания приемника (помечен PWR) 5-ти штырьковый
разъем кабеля типа приемник-SAE.

• Соедините SAE-разъем кабеля приемник-SAE с SAE-разъемом зарядного
устройства.

• Вставьте противоположный конец кабеля в зарядное устройство.
• Подключите зарядное устройство к сети переменного тока с помощью кабеля типа
зарядное устройство-сеть. 

• Включите приемник, нажав и удерживая около 0,5 секунды кнопку включения/
выключения.

Посмотрите, мигает ли BAT СИД, чтобы убедиться, что приемник получает питание от
внешнего источника питания:

• СИД непрерывно горит – используется внешний источник питания, а батареи не
заряжаются.

• СИД мигает раз в секунду - используется внешний источник питания, и батареи
заряжаются.

2.5.1. Включение/Выключение приемника

Чтобы включить приемник, нажмите и удерживайте кнопку включения/выключения
приемника, пока не загорятся светоиндикаторы. Чтобы выключить приемник, нажмите и
удерживайте кнопку включения/выключения не менее одной секунди и не более четырех
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секунд (пока не погаснут светоиндикаторы). Эта задержка (более 1 секунды) защищает
приемник от случайного отключения.

2.6. Соединение приемника и компьютера

С помощью ПО TriVU вы можете настраивать, контролировать и управлять различными
функциями приемника. 

Чтобы выгружать, удалять файлы, управлять примеником, соедините приемник и ПК,
используя один из предложеных ниже способов, и запустите TriVU:

• с помощью Bluetooth® технологии 
• с помощью  кабеля RS232 
• с помощью USB-кабеля (потребуется специальный USB-драйвер, выпускаемый
компанией JAVAD GNSS)

После того, как соединение между приемником и компьютером будет установлено, вы
сможете:

• Настраивать приемник и его составляющие;
• Посылать команды приемнику;
• Выгружать файлы из памяти приемника;
• Загружать новые версии аппаратно-программного обеспечения приемника;
• Загружать файл авторизации опций (OAF).

2.6.1. Установление беспроводного соединения

Приемник TRIUMPH-1 оснащен беспроводной технологией Bluetooth®  для передачи
данных и синхронизации приемника и внешнего устройства, которое тоже поддерживает
технологию  Bluetooth®, например, контроллер Victor, наладонные компьютеры IPAQ,  или
ПК с установленными  адаптерами USB-to-Bluetooth®  или PCMCA-to-Bluetooth®.
Примечание: Изменение установок по умолчанию для порта В повлияет на соединение Bluetooth®. Установки по

умолчанию для порта В: 115200 bps, 8 data bits, 1 stop bit, no parity, и no handshaking.

Процесс установления связи между приемником TRIUMPH-1 и внешним устройством
может варьироваться в зависимости от типа внешнего устройства. В целом, процедура
соединения следующая:
Примечание: Обратитесь к руководству к вашему внешнему устройству для более подробной информации об

установлении Bluetooth®-связи.
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1. Включите внешнее устройство, поддерживающее Bluetooth®-технологию и ваш
приемник. Для внешнего устройства режим по умолчанию - Master; режим
Bluetooth®-модуля приемника - Slave.

2. Проинструктируйте внешнее устройство (Master) найти приемник (Slave).
3. Когда внешнее устройство (Master) найдет приемник, следуйте инструкциям,

прилагаемым к внешнему устройству, по установке Bluetooth®-соединения с
приемником.

4. Соединитесь с необходимым программным обеспечением (например, TriVU).

Если вы не можете установить соединение, убедитесь, что задействован третий слот
приемника:

• Соедините приемник и ПК с помощью RS232-кабеля (см. “Соединение с помощью
кабеля RS232” ниже.

• Запустите TriVU.
• Нажмите Configuration->Receiver, откройте закладку General.
• В поле Turn on/off Slots убедтесь, что стоит флажок во флаговом переключателе Slot

3 (B).

2.6.2. Соединение с помощью кабеля  RS232

1. Используя кабель RS232, соедините последовательный порт своего ПК (как
правило, COM1) с последовательный портом А приемника.

2. Включите приемник и ПК.
3. Соединитесь с необходимым программным обеспечением (например, TriVU).

2.6.3. Соединение с помощью USB�кабеля

Прежде чем устанавливать соединение, убедитесь, что USB-драйвер компании JAVAD
GNSS установлен  на  вашем  компьютере .  Драйвер  можно  скачать  с  веб-сайта :
www.javad.com.

1. Используя USB-кабель, соедините USB-порт приемника и USB-порт ПК.
2. Включите приемник и ПК.
3. Соединитесь с необходимым программным обеспечением (например, TriVU).
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2.7. Настройка Bluetooth®�модуля

Используйте команды GREIS и Manual Mode программы TriVU для того, чтобы:

• получить доступ к Bluetooth®-модулю;
• настраивать Bluetooth®-модуль;
• проверять или изменять настройки модуля.

Чтобы получить доступ к  Bluetooth®-модулю:

1. Соедините компьютер и приемник, как описано в “Соединение приемника и
компьютера” на стр. 29.

2. Запустите программу TriVU. Выберите последовательный порт и нажмите Ok
(Рисунок 2-8).

Рисунок 2�8. Параметры соединения
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3. Нажмите File->Manual Mode (Рисунок 2-9).

Рисунок 2�9. File�>Manual Mode

4. В командной строке введите команды из Табл. 1 и нажмите кнопку Send command
(Рисунок 2-10). Подробнее см. в GREIS (GNSS Receiver External Interface
Specification), имеющемся на сайте компании JAVAD GNSS.

Таблица 1. Команды GREIS для настройки Bluetooth®�модуля

Рисунок 2�10. Manual Mode

Команда Пояснение

set,/par/blt/name,JAVAD GNSS Изменяет имя Bluetooth®-модуля приемника. Можно ввести 
последовательность из 14 символов.

set,/par/blt/pin,1234 Устанавливает Персональный Идентификационный Номар (ПИН)
 Bluetooth®-мордуля. Можно ввести до 16 символов.
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5. Нажмите Exit.
6. Нажмите File->Disconnect, затем File->Exit, чтобы покинуть TriVU. 

2.8. Сбор альманаха

Каждый НИСЗ передает сообщение (альманах), в котором содержится информация о
параметрах его орбиты и парметрах орбит других спутников. Если у приемника есть
альманах, это значительно снижает затраты времени на поиск и захват сигналов НИСЗ. 

Приемник регулярно обновляет альманах и сохраняет его в в своем энергонезависимом
оперативном запоминающем устройстве. 

• Установите приемник (подсоединив, если неободимо, внешнюю антенну) под
открытым небом.

• Включите приемник. Подождите примерно 15 минут, пока приемник соберет
данные альманаха со спутников.

• Если по прошествии 15 минут приемник не начал отслеживать спутники, очистите
энергонезависимое ОЗУ. См. подробнее “Очистка энергонезависимого ОЗУ” на стр.
101.

Альманах следует собирать и/или обновлять:

• Если приемник не использовался долгое время;
• Если последняя позиция приемника, сохраненая в энергонезависимом ОЗУ,
отличается от текущей по меньшей мере на сто километров;

• После загрузки нового файла аторизации опций (OAF);
• После загрузки новой версии аппаратно-программного обеспечения;
• После чистки энергонезависимого ОЗУ;
• Перед началом съемки.
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Глава 3
НАСТРОЙКА TRIUMPH�1

Приемник, который будет работать в качестве базы и подвижный приемник, должны быть
настроены в соответсвии с желаемым типом съмки.

• В приложениях, в которых необходимо получить результаты позиционирования в
режиме реального времени, используются базовый и подвижные приемники.
Базовый приемник (база), установленный в известной точке, передает поправки
пожвижным приемникам (роверам) для вычисления точной позиции. Для передачи
данных от базы к подвижным приемникам необходим радиомодем (УВЧ или GSM). 

• Подвижный приемник использует информацию поправок, получаемых от базовой
станции для вычисления своей точной позиции в одной или нескольких разных
точках. Роверы - это подвижные ГНСС проиемники на вешке, которые сравнивают
информацию, полученную от базовой станции, с данными, полученными ими со
спутников, и расчитывают точную позицию пункта.

• В приложениях, в которых используется последующая пост-обработка данных,
независимые приемники, как правило, записывают кодовые и фазовые измерения,
полученные с общих спутников на протяжении одного и того же интервала времени.
Потом данные с этих приемников обрабатываются с помощью ПО постобработки
(например, ПО JAVAD GNSS Justin).

Для правильной настройки приемника для успешной работы в режиме кинематики
реального времени (RTK), используйте перечень настроек, приведенный ниже. 

• Произведите досъемочную настройку приемника, как описано в Главе 2. 
• Сконфигурируйте один приемник как базовую станцию, а другой (другие) как
ровер(ы). См. “Настройка приемника” на стр. 41.

• Настройте радиомодем для приема/передачи данных.
• Для УВЧ модема, см. “Настройка встроенного УВЧ модема” на стр. 38. 
• Для GSM-модуля, см. “Настройка GSM-модуля” на стр. 39.

• Установите базовый приемник (базу) в точке с известными координатами, чтобы он
начал собирать статические данные и передавать поправки. 

• Установите подвижный приемник (ровер), чтобы он начал собирать RTK-данные.
Подробнее см. “Настройка приемника” на стр. 41.
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3.1. Настройка радиомодема

Встроенный модем может быть по-разному настроен, в зависимости от предполагаемого
использования и нужд пользователя. Чтобы настроить встроенный модем, необходима
программа ModemVU.

ПО ModemVU - это специальное программное обеспечение, выпускаемое компанией
JAVAD GNSS, для настройки и управления встроенными радиомодемами. ModemVU
позволяет следующее:

• Соединить компьютер и встроенный радиомодем с помощью последовательного
порта или технологии Bluetooth®.

• Просмотреть информацию о встроенном радиомодеме.
• Программировать настройки встроенного радиомодема.

Подробное описание программы ModemVU и настроек УВЧ модема и GSM-модуля можно
найти в ModemVU Software Manual на веб-сайте компании JAVAD GNSS www.javad.com.

Для того, чтобы запустить ПО и установить связь с приемником, необходимо выполнить
следующие шаги:

1. При выключенном питании приборов, соединить последовательный порт
компьютера с последовательным портом навигационного приемника.

2. Включить приемник.
3. Запустить на компьютере ранее установленную программу ModemVU. Об

установке программы см. “Установка ModemVU” на стр. 22.
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4. Выбрать нужный последовательный порт (COM-порт) компьютера, к которому
подключен приемник, для установления связи с ПК и нажать кнопку Connect
(Рисунок 3-1).

Рисунок 3�1. Соединение с ModemVU

5. В окне Connecting to device выберите для настройки УВЧ модем или GSM-модуль
(Рисунок 3-2 на стр. 38):

• Для настройки УВЧ модема выберите ON в списке Radio, нажмите Apply, затем
Connect Radio.

• Для настройки GSM модуля выберите Slave, Master или GPRS в списке GSM,
нажмите Apply, затем Connect GSM:

• Slave - если приемник настраивается как база;
• Master - если приемник настравивается как ровер;
• GPRS - для настроек GPRS.
37www.javad.com                                                                                                                                                       



Настройка TRIUMPH�1
Настройка радиомодема
Настройка встроенного УВЧ модема
Рисунок 3�2. Окно Connecting to device

3.1.1. Настройка встроенного УВЧ модема

Примечание: Следуя требованиям по использованию радиооборудования, сохраняйте не менее 20 см между
пользователем и УВЧ модемом.

1. В закладке Radio Link, установите следующие параметры (Табл. 1)  и нажмите Apply 
(Рисунок 3-3 на стр. 39).

Таблица 1. Настройки в закладке Radio Link

Параметр База Ровер

Protocol Выберите Simplex Transmitter 
protocol 

Выберите Simplex receiver protocol

Для базы и ровера тип протокола должен быть одинаковым.

Frequency Установите частоту в полосе 403-470 MГц с шагом 6.25 кГц.
Для базы и ровера должна быть установлена одинаковая частота.

Output power Выберите мощность передачи. - 

Modulation type Задайте тип модуляции, которая будет использоваться. Рекомендуется DQPSK.
Для базы и ровера тип модуляции должен быть одинаковым.

Link Rate Задается автоматически.

Link Space Для баз и ровера ширина спектра должна быть одинаковой.

Forward Error 
Correction

Активно Активно

Scrambling Активно Активно
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Рисунок 3�3. Закладка Radio Link

2. По окончании настройки нажмите File->Disconnect.

3.1.2. Настройка GSM�модуля

Примечание: Следуя требованиям по использованию радиооборудования, сохраняйте не менее 20 см между
пользователем и GSM модемом.

1. В закладке General настройте следующие параметры (Табл. 2) и нажмите  Apply 
(Рисунок 3-4 на стр. 40).

Таблица 2. Настройки в закладке General

Параметр База Ровер

PIN Введите, если необходимо, Персональный Идентификационный Номер (ПИН)
SIM-карты.
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Рисунок 3�4. Закладка General

2. В закладке Master/Slave настройте следующие параметры (Табл. 3) и нажмите Apply
(Рисунок 3-4 на стр. 40).

Таблица 3. Настройки в закладке Master/Slave

Параметр База Ровер

Dial number Не заполнять. Введите телефонный номер GSM 
модема базовой станции.

Send/Receive time out Установите в поле Send Time Out значение 2;
Установите в поле Receive Time Out значение 5.
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Рисунок 3�5. Закладка Master/Slave 

3. Нажмите Apply, затем File->Disconnect.
4. Если необходимо, запустите TriVU и настройте приемник, как базовую станцию.

3.2. Настройка приемника

Приемник TRIUMPH-1 может быть настроен различными способами на различные типы
съемок, будь то RTK или пост-процессинг, например как:

• Статическая (неподвижная) базовая станция - собирает измерения и записывает их в
свою память.

• Базовая станция RTK (база) - собирает измерения, определяет дифференциальные
поправки и передает их RTK роверу (роверам).

• Статический (неподвижный) ровер -  собрает данные наблюдения с тех же
спутников и в тот же период времени, что и статическая база.

• RTK ровер - собирает измерения и принимает поправки с базовой станции RTK и
вычисляет относительную позицию. 

• Ровер, используемый, как повторитель (repeater) - передает измерения базовой
станции RTK другим роверам, находящимся за пределами GPS системы.
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Для настройки приемника, управления файлами, соедините приемник и ПК (контроллер
Victor), используя один  из описанных выше типов соединения и запустите TriVU.

Программа TriVU предназначена для управления спутниковыми радионавигационными
приемниками, выпускаемыми компанией JAVAD GNSS. Настоящая версия TriVU
позволяет:

• осуществлять соединение ПК с приемником JAVAD GNSS через последовательный
и USB порты ПК, а также через Интернет;

• отслеживать количество и состояние НИСЗ, находящихся в поле радиовидимости
антенны приемника;

• отображать текущую позицию и время приемника в режиме реального времени;
• управлять записью данных во внутренний файл приемника;
• переписывать файлы данных из внутренней памяти приемника на жесткий диск ПК;
• отображать и программировать основные установки приемника (интервал записи
данных, режим вычисления позиции и др.);

• отображать и загружать опции премника;
• загружать новое аппартно-программное обеспечение.

Примечание: Полное описание возможностей программы TriVU выходит за рамки данного руководства.
Подробную и детальную информацю о TriVU можно найти в руководстве пользователя TriVU
Software Manual на веб-сайте компании JAVAD GNSS (www.javad.com).

1. Соедините приемник и компьютер, как описано в “Соединение приемника и
компьютера” на стр. 29.
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2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 3-6).

Рисунок 3�6. Параметры соединения

3. Нажмите Configuration->Receiver.
Примечание: Нажимайте Apply всякий раз после изменений конфигурации, в противном случае приемник не

зарегистрирует изменений.
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4. В закладке General нажмите кнопку Set all parameters to defaults и установите
параметр Antenna  в значение Auto, Internal или External, если используется внешняя
антенна (Рисунок 3-7).

Рисунок 3�7. Set all parameters to defaults

5. Перейдите в закладку MinPad и настройте следующие параметры (Табл. 4), а затем
нажмите  Apply (Рисунок 3-8 на стр. 45).

Таблица 4. Настройки в закладке MinPad

Параметр База Ровер

Recording interval 15 сек.

Elevation mask angle 15 градусов.

File name prefix Введите уникальный идентификатор (ID), например три 
последние цифры серийного номера приемника.

FN key mode (включает/выключает запись жданных при использовании 
кнопки FN)

Для записи статических (Static) 
данных, выберите LED blink 
mode switch.

Для записи RTK данных, 
выберите Occupation mode 
switch.

Initial data collection 
dynamic mode

- Выберите Kinematic.
(Эта настройка для съемки 
траектории)
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Рисунок 3�8. Настройки приемника – MinPad для записи данных

6. Перейдите в закладку Positioning и установите угол возвышения (Elevation mask)  15
(Рисунок 3-9), затем нажмите Apply.

Рисунок 3�9. Настройки приемника – Elevation Mask

7. Для базового приемника (базы) откройте закладку Base и настройте следующие
параметры (Рисунок 3-10 на стр. 46), затем нажмите Apply.
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• GPS/GLO at one time – активен
• Antenna position - введите значения для полей Lat (широта), Lon (долгота), и Alt

(высота). Установить координаты можно одним из трех перечисленных ниже
способов:

- Ввести в поля Lat, Lon и Alt координаты опорной станции, полученные с
высокой точность из ранее проводившихся геодезических работ.
- Использовать текущие абсолютные координаты, нажав на кнопку Get from
receiver.
- Использовать в качестве опорных координаты, полученные из осреднения
абсолютных координат на интервале, заданном в поле Avg.Span. Этот способ
доступен, только если переключатель Averaged установлен во включенное
состояние. Нажмите кнопку Apply.

8. Нажмите Tools->Reset receiver. Проверьте координаты базы в закладке Base, они
должны соответствовать координатам, полученным по средней величине. Если
координаты нулевые, нажмите кнопку Refresh.

Рисунок 3�10. Закладка Base

9. Для подвижного приемника (ровера) откройте закладку Rover и произведите
настройку следующих параметров, затем нажмите Apply (Рисунок 3-11 на стр. 47).

• Positioning Mode – для съемки с пост-обработкой выберите Standalone; для RTK-
съемки выберите RTK float или RTK fixed.
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• RTK Parameters, RTK mode – выберите или Extrapolation для RTK float (kinematic)
или Delay для RTK fixed (static).

– Если выбран режим Extrapolation, то ровер будет экстраполировать измерения
фазы несущей частоты, выполненные базой, при вычислении своих собственных
относительных координат. 
.– Если же выбран режим Delay, ровер не будет производить экстраполяцию
измерений, выполняемых в базе. Вместо этого, механизм RTK будет вычислять:
либо свои относительные координаты (для эпох, которым соответствуют
измерения, полученные от базы), либо свои абсолютные координаты (если
измерения, выполняемые базой, недоступны для ровера).

• RTK Parameters, Dynamics – выберите Static или Kinematic.
• RTK Parameters, Ambiguity fixing level – (не активно при RTK Float) выберите Low
или Medium, или High. Кнопка Low соответствует вероятности 95%, кнопка Medium
соответствует вероятности 99,5%, кнопка High соответствует вероятности 99,9%.
Если невозможно разрешить неоднозначность с вероятностью большей или равной
выбранной, решение считается плавающим.

Рисунок 3�11. Закладка Rover 

10. Для съемки в режиме RTK перейдите в закладку Ports произведите настройки
следующих параметров (Табл. 5), затем нажмите Apply (Рисунок 3-12 на стр. 48).

Примечание: Для съемки с последующей пост-обработкой оставьте значения всех параметров по умолчанию.
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Таблица 5. Настройки в закладке Ports 

Рисунок 3�12. Настройки базы и ровера для RTK съемки – Ports

11. Перейдите в закладку Advanced, а затем в закладку Multipath. Настройте следующие
параметры и нажмите Apply (Рисунок 3-13).

• Code multipath reduction – активен

Параметр База Ровер

Input - Выберите формат 
дифференциальных поправок, 
который выбран у базы

Output Выберите тип 
дифференциальных поправок.

Выберите “None”.

Period (sec) Введите интервал передави 
дифференциальных поправое.

-

Baud rate Выберите скорость передачи, которая будет использоваться для 
передачи диффернециальных поправок из платы приемника в 
модем.
Скорость передачи должна соответствовать скорости 
последовательного порта модема (serial port).

RTS/CTS Активировать.
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• Carrier multipath reduction – активен

Рисунок 3�13. Настройка параметров подавления многолучевости

12.  Нажмите OK, чтобы сохранить настройки и закройте диалоговое окно. настройки
приемника будут сохраняться в нем неизменными до тех пор, пока вы сами их не
изхмените или не произвеете очистку энергонезависимого ОЗУ. Для более
детального описания настроек базы и ровера обращайтесь к TriVU Software Manual.

13.  продолжайте настройки или нажмите File->Disconnect, а затем File->Exit, чтобы
выйти из программы TriVU.
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3.3. Настройка MinPad 

Минимальный пользовательский интерфейс (MinPad) приемника TRIUMPH-1 состоит из
двух кнопок (Вкл/Выкл и FN) и шести светодиодов (СИД) (SAT, REC, BAT, POS, BT и
MOD), которые показывают статус приемника и его действия (Рисунок 3-14).

Рисунок 3�14. TRIUMPH�1 MinPad

MinPad обладает множеством функций. С его помощью можно:

• Включать/выключать приемник, вводить его в спящий режим и режим нулевого
энергопотребления Zero power (кнопка включения/выключения).

• Включать/выключать запись данных (кнопка FN).
• Менять информационный режим приемника (кнопка FN).
• Контролировать количество отслеживаемых спутников (SAT).
• Контролировать статус записи данных (REC).
• Контролировать момент записи данных в память приемника (REC).
• Контролировать статус пост-процессингового режима (статический или
динамический), когда выполняет ся кинематиче ская съемка с постобработкой с
помощью кнопки FN (REC).

• Контролировать статус батарей (полный, средний или низкий уровень зарядки)
(BAT).

• Контролировать источник питания приемника (BAT).
• Контролировать статус модема (MOD).
• Контролировать статус Bluetooth®-модуля (BT)
• Контролировать статус полученного решения (POS)

Используйте TriVU для настройки параметров MinPad. Подробное описание всех
возможных конфигураций MinPad можно найти в TriVU Software Manual.
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1. Соедините приемник и компьютер, как описано в “Соединение приемника и
компьютера” на стр. 29.

2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 3-6).

Рисунок 3�15. Параметры соединения

3. Нажмите Configuration->Receiver и откройте закладку MinPad. Произведите
следующие настройки и нажмите Apply. Ниже даны описания следующих
параметров:

• Recording interval на стр. 52.
• Elevation mask for log file на стр. 52.
• File name prefix на стр. 52.
• Always append to the file на стр. 53.
• Files Creation mode на стр. 53.
• Automatic File Rotation Mode (AFRM) на стр. 53.
• FN key mode на стр. 54.
• Initial data collection dynamic mode на стр. 54.
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• Data recording auto-start на стр. 54.

Рисунок 3�16. Закладка MinPad

Recording Interval 

В поле Recording interval пользователь указывает интервал времени, с которым будет
производиться запись сообщений в файл приемника, созданного с использованием кнопки
FN, расположенной на панели MinPad, или созданного через режим автоматического
создания файлов (AFRM – Automatic File Rotation Mode). В этом поле можно задать
значения от 0 до 86400 секунд.

Значение по умолчанию: 1 секунда.

Elevation Mask for Log File 

В поле Elevation mask for Log file пользователь определяет минимальный угол возвышения
для НИСЗ, данные от которых будут записываться в файл приемника, созданный при
помощи кнопки FN.

Значение по умолчанию: пять градусов.

File Name Prefix

Используя поле File name prefix пользователь может задать приставку, которая будет
добавляться к имени файла при его создании с помощью кнопки FN. В этом поле можно
указать до 20 символов.
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По умолчанию используется приставка log.

Имя файла имеет следующую структуру::
<prefix><month><day><sequential alphabet letter>

Имя файла зависит от месяца и дня создания фала и дополнительно буквенного суффикса,
чтобы избежать путаницы между файлами, созданными в один день.

Always Append to the File

Если пользователь желает, чтобы все новые данные поступали всегда только в один,
заранее определенный файл, ему следует указать в поле Always append to the file имя файла,
в который будут поступать данные. Имя файла может содержать до 20 символов.

Files Creation Mode 

Пользователь может выбрать, в каком режиме будет работать кнопка FN. 

• Если установлена кнопка выбора Log file, то нажатие на кнопку FN вызовет либо
открытие log-файла, либо его закрытие, в зависимости от предыдущих действий. 

• Если же установлена кнопка выбора AFRM, то нажатие на кнопку FN приведет либо
к  выключению  режима  AFRM, либо  к  его  включению ,  в  зависимости  от
предыдущих установок.

Automatic File Rotation Mode (AFRM) 

• Поле Period определяет промежуток времени, по прошествии которого механизм
AFRM закроет текущий файл и создаст новый. Допустимые значения от 60 до 86400
секунд. Значение по умолчанию: 3600 секунд.

• В поле Phase указывается фаза (постоянный временной сдвиг) автоматического
создания файлов. Допустимые значения от 0 до 86400 секунд. Значение по
умолчанию: 0 секунд.

• Задать количество файлов, которое будет создано до того, как режим AFRM
выключится, можно в поле Files (total). Нулевое значение этого параметра означает
создание неограниченного количества файлов. Допустимые значения от 0 до [231-
1]. Значение по умолчанию: 0 (ноль).

• В поле Files (remain) можно посмотреть, сколько файлов осталось открыть
механизму AFRM до момента его выключения. Допустимые значения от 0 до [231-
1]. Значение по умолчанию: 0 (ноль).

• Переключатель Automatically remove old files, находящийся во включенном
состоянии, заставляет приемник, не имеющий свободной памяти для продолжения
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записи данных, удалить файлы - первые из ранее созданных. Значение по
умолчанию: off (выключено).

FN Key Mode 

Пользуясь этой группой кнопок выбора, пользователь может установить желаемую
реакцию приемника на кратковременное нажатие кнопки FN (<1 cекунды). В режиме LED
blink mode switch кратковременное нажатие кнопки FN переключает информационные
режимы панели MinPad. Подробнее об информационных режимах читайте в документации
MinPad User Manual и TriVU Software Manual.

В режиме Occupation mode switch кратковременным нажатием на кнопку FN можно менять
тип записываемого файла со статического на динамический и обратно. 

Initial Data Collection Dynamic Mode

Эти кнопки позволяют выбрать начальный тип файлов, которые будут созданы с
использованием MinPad. Можно задать либо Static (статический), либо Kinematic
(динамический) тип.

Data Recording Auto�start 

Пользователь может запрограммировать поведение приемника при сбое питания. Другими
словами, после восстановления питания приемник определит, в соответствии с выбранной
кнопкой, следует ли ему продолжить запись данных в файл или нет. В табл. 2-2 приведены
возможные варианты работы данного алгоритма.

Таблица 6. Варианты функционирования режима Data recording auto�start

До сбоя питания...
Активированный флаговый переключатель

Off On Always

Производилась запись 
в файл, указанный в 
поле Always append to 
the file

Запись в файл не 
продолжится.

Запись в файл будет 
продолжена.

Запись в файл будет 
продолжена.

Производилась запись 
в файл с именем, 
определенным по 
умолчанию

Запись в файл не 
продолжится.

Запись будет 
продолжена в новый 
файл.

Запись будет продолжена в 
новый файл.

Запись в файл, 
указанный в поле 
Always append to the 
file не производилась.

Файл не будет 
открыт

Файл не будет 
открыт

Будет открыт указанный файл, 
в который начнется запись
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В режиме Always запись в файл (новый или указанный) также будет начата или продолжена
после включения приемника путем нажатия кнопки включения питания; после выполнении
операции аппаратного сброса Reset receiver; после выведения приемника из режима Sleep.
Примечание: Настройка Data recording auto-start не обеспечивает автоматического включения приемника после

восстановления питания. Эта настройка управляет лишь записью данных во внутренний файл
приемника.

Запись в файл с 
именем, определенным 
по умолчанию не 
производилась

Файл не будет 
открыт

Файл не будет 
открыт

Будет открыт указанный файл, 
в который начнется запись

До сбоя питания...
Активированный флаговый переключатель

Off On Always
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Глава 4
УСТАНОВКА И СЪЕМКА

После того, как приемник был настроен на определенный вид съемки, необходимо
установить примник и измерить высоту антенны, прежде чес начать съемку. Благодаря
интерфейсу MinPad легко осущетсвляется запись данных, изменение режимов приемника,
просмотр информации о записи данных во время съемки.

4.1. Установка приемника

Классическая геодезическая система состоит из базы, установленой в определенной точке с
известными координатами, и ровера, настроенного как подвижный коллектор данных.
После установки базового и подвижного приемников, необходимо рассчитать высоту
антенны. Прежде, чем начать сбор данных, убедитесь, что у базы и ровера есть собранный
альманах (см. “Сбор альманаха” на стр. 33).

4.1.1. Установка приемника

Базовая станция настроена прежде, чем будет производится настройка подвижного
приемника (ровера). 

Чтобы установить базовый приемник:

1. Поместите приемник на подходящем штативе или RTK Caddy в известной
контрольной точке.

2. Отцентрируйте приемник над тем пунктом, где будет проводиться сбор данных. В
большинстве случаев, это должно быть место под открытым, ничем не заслоняемым
небоcводом.

3. Подсоедените, если необходимо, дополнительное оборудование.

Чтобы установить подвижный приемник:

1. Поместите приемник на подходящем штативе или RTK Caddy в необходимой точке. 
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4.1.2. Измерение высоты антенны

Приемник вычисляет координаты фазового центра антенны. Чтобы определить координаты
конкретной точки, необходимо иметь следующие данные:

• Измеренную высоту антенны над конкретной точкой,
• Тип измерения высоты антенны,
• Модель используемой антенны

Есть два типа измерений:

• Вертикаль - высота антенны измеряется непосредственно от выбранной точки
(маркер )  до  опорной  точки  антенны  (antenna  re ference  poin t  (ARP)) ,
располагающейся обычно внизу антенны на плоскости крепления к штативу.

• Наклон - высота антенны определяется через наклонную высоту, измеряемую от
выбранной точки (маркер) до метки на нижнем краю антенны.

1. Измерьте высоту антенны.
2. Зафиксируйте высоту антенны, название точки и время начала работы в полевых

записях.

4.1.3. Установка внешней антенны

Приемник TRIUMPH-1 можно также использовать и с внешней антенной. Следуйте
нижеприведенным инструкциям, чтобы подключить внешнюю антенну к приемнику и
измерить ее смещение. 

1. Установите антенну на подходящем штативе и отцентрируйте ее над тем пунктом,
где будет производиться сбор данных.

2. Измерьте высоту антенны, как описано в “Измерение высоты антенны” на стр. 58.
3. Зафиксируйте высоту антенны, название точки и время начала работы в полевых

записях.
4. Cоедините гибким RF-кабелем внешнюю антенну c антенным разъемом на нижней

панели приемника.

По умолчанию, антенна в приемнике стоит в режиме Auto, то есть приемник определяет
антенну автоматически (встроенная или внешняя). Если вы изменяли эти установки, или
приемник не определил внешнюю антенну авоматически, следуйте инструкции на стр. 44,
чтобы настроить параметры внешней антенны.
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4.1.4. Сбор данных

1. Включите приемник. SAT СИД сначала будет мигать красным.
2. Когда приемник начнет отследивать один и более спутников, SAT СИД начнет

мигать зеленым для GPS спутников и оранжевым для спутников ГЛОНАСС. 
3. Красный цвет POS СИДа означает, что решение не было получено. Четыре и более

спутников обеспечивают оптимальное позиционирование.
4. Когда POS СИД загорится зеленым, это означает, что решение получено и можно

начинать съемку.
Процесс захвата и начала слежения за спутниками занимает, как правило, менее
одной минуты. На новом месте, под кронами деревьев или после того как был
произведен аппаратный сброс приемника это может занять несколько минут.

5. Чтобы начать  запись данных, нажмите и удерживайте кнопку FN (не менее одной
секунды, но не более пяти секукнд).

6. Отпустите кнопку FN, когда REC (recording) СИД загорится зеленым. Это означает,
что файл открыт и запись данных начата. REC СИД вспыхивает каждый раз, как
данные сохраняются во внутренней памяти приемника.

7. Чтобы закончить запись, нажмите кнопку FN и удерживайте, пока не погаснет REC
СИД.

8. Чтобы выключить приемник, нажмите и удерживайте кнопку Вкл/Выкл до тех пор,
пока все светодиоды не погаснут.
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4.2. Использование MinPad

Минимальный пользовательский интерфейс MinPad используется для отображения и
контроля входящих/исходящих данных (Рисунок 4-1).

Рисунок 4�1. MinPad интерфес приемника TRIUMPH�1

Полное описание интерфеса MinPad cм. в “MinPad” на стр. 16 . 

Чтобы включить/выключить приемник, нажмите кнопку Вкл/Выкл (Рисунок 4-1). 

• Чтобы включить, нажмите кнопку Вкл/Выкл и удерживайте, пока не замигают
светодиоды.

• Чтобы выключить, нажмите кнопку Вкл/Выкл и держите до тех пор, пока  не
погаснут все светодиоды.

Чтобы начать/остановить запись данных, нажмитк кнопку FN и удерживайте 1–5 секунд
(Рисунок 4-1).

• Во время записи данных REC СИД горит зеленым. Используйте программу TriVU
для настройки интервала записи данных.См. подробнеее “Recording Interval” на стр.
52.

• REC СИД вспыхивает зеленым каждый раз, когда производится запись информации
в память приемника.

• Если REC СИД горит красным, значит, у приемника нет больше места в памяти для
записи информации или имеет место какой-то аппаратный сбой,  или у приеника
просроченный файл авторизации опций (OAF) (см. подробнее  “Файл авторизации
опций (OAF)” на стр. 19).

 Кнопка FNВкл/выкл

BAT REC
BT

MOD SAT
POS
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Используйте TriVU, чтобы активировать желаемые режимы кнопки FN в приемнике: либо
“LED blink mode switch” для статической съемки, либо “Occupation mode switch” для
кинематической съемки. см. подробнее “FN Key Mode” на стр. 54.

Всякий раз, когда вы начинаете/останавливаете запись данных, открывается новый файл,
или происходит запись в уже открытый. См. подробнее о насройках этой функции в See
“Always Append to the File” на стр. 53 и “Files Creation Mode” на стр. 53.

Чтобы переключаться между режимами пост-обработки, нажмите кнопку FN неменее,
чем на 1 секунду, если “Occupation mode switch” был активирован с помощью TriVU.

Чтобы менять скорость передачи последовательно порта приемника, нажмите и
удерживайте кнопку FN в течение 5–8 секунд. Через пять секунд REC СИД загорится
красным.Отпустите кнопку FN в течение трех последующих секунд.

4.3. Статическая съемка 

Статическая съемка - это классический вид съемки хорошо приспособленный для любой
длины базовой линии (короткой, средней, длинной). Один приемник (базовый) находится
на точке с известными координатами, другой устанавливают на точку, координаты которой
необходимо определить, и производят одновременную запись измерений во внутреннюю
память для их последующей обработки на компьютере и вычисления координат. Весь
процесс измерений полностью автоматизирован. Время наблюдения зависит от длины
базовой линии (расстояния от базового до подвижного приемника), количества видимых
спутников и т.д.

Как правило, одночастотные приемники используются на базовых линиях, длина которых
не  превышает  15 км .  Для  базовых  линий  длиннее  15 км  следует  использовать
двухчастотные приемники. 

У двухчастотных приемников два основных преимущества. Во-первых, двухчастотный
приемник может учитывать и устранять влияние ионосферы на кодовые и фазовые
измерения, обеспечивая на длинных базовых линиях, или в условиях магнитных бурь более
высокую точность измерений, по сравнению с одночастотным приемником.

Во-вторых, двухчастотный приемник требует гораздо меньшего времени наблюдения,
чтобы получить требуемую точность.

После окончания съемки, собранные приемником данные могут быть выгружены в ПК для
последующей постобработки с помощью программного обеспечения для постобработки,
например, JAVAD GNSS Justin.
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4.4. Кинематическая (Stop & Go) съемка

Режим Stop&Go - cпециальный вид кинематической съемки, при котором после
разрешения  неоднозначности  в  начальной  точке  мобильный  приемник  может
перемещаться между другими пунктами, но без потери захвата спутниковых сигналов. Для
определения местоположения промежуточных точек на геодезическом уровне точности
таким способом достаточно фиксации всего нескольких эпох. Если случается потеря
захвата сигналов спутников, то необходимо выполнить новое разрешение неоднозначности
на очередной точке.

Базовая станция установлена на известной позиции, например, на геодезическом знаке.
Этот приемник отслеживает спутники и записывает данные в память. Ровер установлен в
некой точке и записывает данные в статическом режиме 2-10 минут. По окончанию записи
данных в этой точке, ровер перемещается на следующую. в момент движения ровер
находится в кинематическом режиме, а во время стояния на точке - в статическом.

1. Установите ровер в неизвестной точке и включите приемник. Дайте возможность
приемнику собрать статические данные в течение двух-десяти минут. REC LED
будет желтый.

2. Проверьте по сигналам SAT СИДа, что спутники отслеживаются. 
3. По окончании нажмите кнопку FN менее, чем на 1 секунду, чтобы перевести ровер в

кинематический режим.
4. Перенесите ровер на следующую снимаемую точку, нажмите кнопку FN менее, чем

на 1 секунду и собирайте статические данные в течение 2-10 минут. 
5. Повторяйте шаги пять и шесть до тех пор, пока не будут сняты все точки. Время

стояния на точке зависит от тех же факторов, что и при статической съемке. 
6. По окончании, нажмите и удерживайте кнопку FN от одной до пяти секунд , чтобы

остановить запись данных. Выключите при необходимости приемник. Этот метод
съемки позволяет оператору снизить время стояния на точке, и позволяет снять
большее количество точек за тот же временной интервал. 

Примечание: Запомните, что если REC СИД мигает зеленым, то текущий режим - динамический, а если мигает
оранжевым - статический.

4.5. Съемка в режиме RTK

RTK - фазовый дифференциальный режим местоопределения подвижных обьектов в
режиме реального времени, при котором данные, например, дифференциальные поправки,
передаются от базы к одному или нескольким роверам в режиме реального времени.
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При съемке в режиме RTK, так же, как и в кинематической съемке, описанной выше, один
приемник стоит неподвижно и служит контрольной станцией, а другой приемник работает
как ровер, то есть передвигается с точки на точку.  

В отличие от кинематической съемки с дальнейшей пост-обработкой,  в режиме RTK
используется связь между базой и ровером. Используя радиомодемную связь, базовый
приемник передает свои измерения и данные о своем положении роверу. Ровер,
основываясь на переданных данных и на данных своего наблюдения, незамедлительно
производит анализ базовой линиии и выдает результат. О специальных настройках,
используемых при съемке в режиме RTK, см. “Настройка радиомодема” на стр. 36 и
“Настройка приемника” на стр. 41.

Обычно, приемник начинает выдавать координаты фазового центра антенны через 10-30
секунд. А УВЧ модему или GSM ьщдулю для синхронизации может понадобиться около 60
минут.

Геодезические координаты можно просмотреть в закладке Location, и они всегда
представлены  в системе координат WGS84 и могут иметь четыре типа решений: 

• Standalone означает, что координаты получены с использованием только одного
приемника.

• Code differential означает, что для вычисления своего собственного положения
приемник использовал не только свои кодовые измерения, но и дифференциальные
поправки, полученные с опорной станции.

• RTK float означает, что для вычисления своего собственного положения приемник
использовал свои измерения фазы несущей вместе с аналогичными измерениями,
выполненными на опорной станции. В этом режиме механизм RTK не фиксирует
целые неоднозначности, а использует их плавающие оценки.

• RTK fixed – аналогичен предыдущему режиму. Основное отличие состоит в том, что
в этом режиме механизм RTK фиксирует целые неоднозначности.

Поле LQ описывает состояние полученных приемником дифференциальных сообщений.
Оно содержит следующую информацию:

• Качество канала передачи данных, выраженное в процентах.
• Время, прошедшее с момента получения последнего сообщения, в секундах.
• Количество полученных сообщений без ошибок.
• Количество испорченных сообщений.

Если приемник не получает дифференциальных сообщений или ни один из портов
приемника не сконфигурирован для приема этих сообщений, поле LQ будет либо пустым,
либо примет вид 100%(999,0000,0000). 
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Глава 5
УПРАВЛЕНИЕ ПРИЕМНИКОМ 
И ФАЙЛАМИ

Если после съемки необходимо выполнить пост-обработку снятых данных, то файлы из
приемника следует выгрузить в компьютер.

Выгрузка и удаление файлов также освобождает память приемника для последующих
съемок. Иногда приходится очищать энергонезависимое ОЗУ, чтобы избежать проблем со
связью и отслеживанием спутников. 

В процессе работы с приемникомм ожет понадобиться загрузить новый файл авторизации
опций (OAF), загузить новую версию аппаратно-программного обеспечения.

5.1. Выгрузка файлов в компьютер

После  окончания  съемки ,  вы  можете  выгрузить  сохраненные  файлы  в  ПК  для
последующей обработки, копирования или хранения. Так как память приемника способна
вместить лишь ограниченное число файлов, то выгрузка файлов в ПК гарантирует, что ни
один файл не пропадет. 

Выгружайте файлы по-возможности сразу после окончания процесса сбора данных. С
помощью программы TriVU вы можете выгружать и удалять файлы с вашего приемника.

1. Соедините приемник и компьютер, как описано в “Соединение приемника и
компьютера” на стр. 29.
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2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 5-1).

Рисунок 5�1. Параметры соединения

3. Нажмите File ->File Manager, затем откройте закладку Download path в диалоговом
окне File Manager.

4. Найдите папку или создайте новую (используйте кнопку Create) в которую будут
выгружаться файлы. (Рисунок 5-2).

Рисунок 5�2. Закладка Download path
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5. Перейдите в закладку Download files и выберите файл(ы) для выгрузки (Рисунок 5-
3).

6. Чтобы выделить несколько файлов, удерживайте клавишу Shift и выбирайте сразу
несколько файлов; или, удерживая клавшу Ctrl, выбирайте файлы по одному.

Рисунок 5�3. Закладка Download Files

7. Нажмите кнопку Download. Во время процесса выгрузки индикатор состояния будет
отображать для каждого файла следующее (Рисунок 5-4 на стр. 68):

• Красный индикатор – файл выгружается.
• Зеленый индикатор – файл успешно выгружен.
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Рисунок 5�4. Download Files – Статус

8. По окончанию выгрузки нажмите Exit в окне File Manager.
9. Продолжайте работу с приемником, или нажмите File->Disconnect, а затем File-

>Exit, чтобы выйти из TriVU.

5.2. Удаление файлов

Чтобы удалить файлы из памяти приемника следуйцте инструкции:

1. Соедините приемник и компьютер, как описано в “Соединение приемника и
компьютера” на стр. 29.
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2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 5-5).

Рисунок 5�5. Параметры соединения

3. Нажмите File ->File Manager, затем откройте закладку Current log files  и выберите
файлы, которые нужно удалить (Рисунок 5-6).

Рисунок 5�6. Закладка Current log files

4. Чтобы выделить несколько файлов, удерживайте клавишу Shift и выбирайте сразу
несколько файлов; или, удерживая клавшу Ctrl, выбирайте файлы по одному.
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5. Нажмите Delete (Рисунок 5-6 на стр. 69).
6. Нажмите Yes в окне подтверждения удаления файлов. TriVU удалит выбранные

файлы.
7. Нажмите Exit в окне File Manager.
8. Продолжайте работу с приемником, или нажмите File->Disconnect, а затем File-

>Exit, чтобы выйти из TriVU.

5.3. Управление опциями приемника

5.3.1. Проверка OAF

Примечание: Полный список опций и их описание см. на сайте компании JAVAD GNSS.

Проверить статус опций приемника, а также загрузить новый файл авторизации опций
(OAF), возможно, используя кабель RS232, Bluetoorh соединение или USB, ПК и
программу TriVU. Подробное описание программы см. в TriVU Software Manual.

1. Соедините приемник и компьютер, как описано в “Соединение приемника и
компьютера” на стр. 29.

2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 5-7).

Рисунок 5�7. Параметры соединения
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3. Нажмите Tools->Receiver Options. Откроется диалоговое окно Options Manager
(Рисунок 5-8), которое содержит следующую информацию:

• Option name – наименование/описание опции.
• Current – текущий статус опции.
• Purchased – приобретена опция или нет.
• Leased – арендована опция или нет.
• Expiration date – дата, когда опция будет заблокирована.

Так как опция может быть куплена или арендована, то текущий статус "Current"
отображает текущее значение. Опции имеют следующие значения:

• -1 или "-----" – данная опция не поддерживается аппаратно-программным
обеспечением.

• 0 – опция отключена.
• целое положительное число – опция включена.
• yes или no – опция включена или выключена соответственно.

Рисунок 5�8. Окно  Option manager 
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5.3.2. Загрузка OAF

Дилеры компании JAVAD GNSS обеспечивают пользователей файлами авторизации опций
(OAF). По любому вопросу, связанному с фалами авторизации опций, обращайтесь по
адресу  электронной  почты  options@javad.com. Пожалуйста ,  имейте  наготове
идентификационный (ID) номер вашего приемника (см. “Проверка версии аппаратно-
программного обеспечения” на стр. 76).

1. Чтобы загрузить новый файл авторизации опций (OAF), следуйте пунктам один и
два инструкции, описанной в “Проверка OAF” на стр. 70. 

2. Нажмите кнопку Load внизу окна Option Manager  (см. Рисунок 5-8 на стр. 71).
3. Найдите папку, в которой хранится новый файл авторизации опций. Такой файл

имеет расширение .jpo, и он уникален для каждого приемника (Рисунок 5-9).

Рисунок 5�9. Загрузка OAF

4. Выберите нужный файл и нажмите Open. Новые опции будут загружены в
приемник, и окно Option Manager обновится.

5. По окончанию нажмите File->Disconnect, затем File->Exit, чтобы выйти из TriVU.
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5.4. Управление памятью приемника

Когда приемник используется в статических или динамических приложениях, может
потребоваться информация о размере памяти, которую занимает записанный файл.
Специальный размер памяти зависит от типа записываемых данных. С помощью
приведенной ниже формулы можно расчитать приблизительный размер записываемого
файла.

• SS – предполагаемый размер одной эпохи сырых данных в записываемом файле
(выраженный в байтах).

• N – число наблюдаемых НИСЗ в эпоху.

Когда записываются только данные L1: SS = 183 + 22*N

Когда записываются данные L1 и L2: SS = 230 + 44*N

5.5. Очистка энергонезависимого ОЗУ

Энергонезависимoe оперативное запоминающее устройство (NVRAM) хранит данные,
необходимые для отслеживания спутниковых сигналов (местоположение приемника,
эфемериды и т.д.), а также текущие значения всех параметров приемника. Стирание
энергонезависимого ОЗУ может помочь разрешить возникшие проблемы в отслеживании
спутников.

Помните, что после того, как вы произвели очистку энергозависимогу ОЗУ, приемнику
потребуется некоторое время для того, чтобы заново собрать эфемеридную информацию и
вычислить свое местоположение.

После очистки энергонезависимого ОЗУ все параметры приемника установятся в значения,
заданные по умолчанию. Поэтому, для того чтобы восстановить прежние установки
(определенные до процедуры стирания энергонезависимого ОЗУ), вам нужно будет
настроить их заново.

В энергонезависимом ОЗУ хранится информация о файловой системе приемника. После
очистки энергонезависимого ОЗУ светодиодный индикатор с маркировкой REC будет
мигать желтым цветом на протяжении нескольких секунд, показывая тем самым, что
приемник проверяет файловую систему.

Вы можете очистить энергонезависимое ОЗУ с помощью минимального интерфейса
MinPad или с помощью програмы TriVU.
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5.5.1. Очистка с помощью MinPad

1. Выключите приемник с помощью кнопки включения/выключения..
2. Нажмите и удерживайте кнопку FN.
3. Нажмите и удерживайте кнопку включения/выключения примерно секунду. 
4. Отпустите кнопку включения/выключения, продолжая удерживать кнопку FN.
5. Подождите, пока светодиодные индикаторы SAT и REC загорятся зеленым.
6. Подождите, пока светодиодные индикаторы SAT и REC загорятся желтым.
7. Как только светодиодные индикаторы SAT и REC замигали желтым цветом,

отпустите кнопку FN.

5.5.2. Очиска с помощью TriVu

1. Соедините приемник и компьютер, как описано в “Соединение приемника и 
компьютера” на стр. 29.

2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 5-10).

Рисунок 5�10. Параметры соединения
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3. Нажмите Tools->Clear NVRAM (Рисунок 5-11).

Рисунок 5�11. Clear NVRAM

4. Нажмите OK в окне подтверждения очистки энергонезависимого ОЗУ (NVRAM).
REC СИД быстро мигает зеленым и красным; SAT СИД мигает красным. Связь с
приемником будет автоматически разорвана, как только энергонезависимое ОЗУ
будет очищено.

5.6. Смена режимов работы приемника

Приемник TRIUMPH-1 поддерживает следующие режимы: 

• Нормальный режим - для стандартных режимов съемки;
• Спящий режим - останавливает запись данных, но приемник остается включенным.

5.6.1. Спящий режим

Чтобы ввести приемник в спящий режим, следуйте инструкции:

1. Включите приемник с помощью кнопки включения/выключения.
2. Нажмите и удерживайте кнопку включения/выключения дольше четырех секунд, но

менее восьми секунд. SAT СИД загорится желтым. Приемник перейдет в спящий
режим.

3. Приемник включится, как только появится какая-либо активность по RS232-порту.
Примечание: Нажатие и удерживание кнопки включения/выключения дольше 14 секунд не приведет ни к каким

результатам. Это защита приемника от залипания кнопок.
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5.7. Проверка версии аппаратно�программного обеспечения

Чтобы проверить версию аппаратно-программного обеспечения вашего приемника
используйте TriVU.

1. Соедините приемник и компьютер, как описано в “Соединение приемника и 
компьютера” на стр. 29.

2. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 5-12).

Рисунок 5�12. Параметры соединения

3. Нажмите Help->About TriVU (Рисунок 5-13).

Рисунок 5�13. Help�>About
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Откроется диалоговое окно About TriVU  (Рисунок 5-14).

Рисунок 5�14. Окно About TriVU

Окно About TriVU отображает важную информацию о свойствах приемника, о
версии аппаратно-программного обеспечения. Здесь вы найдете все, что вам
понадобится для контакта с компанией JAVAD GNSS, службой подержки или вашим
дилером:

• Тип приемника (Receiver model);
• Идентификационный номер приемника (Receiver ID);
• Версия аппаратно-программного обеспечения (Firmware version).

4. По оеончанию нажмите OK, затем нажмите File->Disconnect, затем File->Exit,
чтобы покинуть TriVU.

5.8. Загрузка нового аппаратно�программного обеспечения

И базовый приемник и роверы должны иметь одинаковую версию аппаратно-программного
обеспечения. Пользуйтесь последними версиями аппаратно-программного обеспечения,
которые можно скачать с сайта компании JAVAD GNSS.

Чтобы загрузить в приемник новую версию аппаратно-программного обеспечения
используйте TriVU. Пожробную информацию вы найдете в TriVU Software Manual.

1. Скачайте на ваш компьютер комплект файлов с новой версией аппаратно-
программного обеспечения.

2. Соедините приемник и компьютер, как описано в “Соединение приемника и
компьютера” на стр. 29.
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3. Запустите TriVU. Выберите порт (COM) и нажмите Ok (Рисунок 5-15).

Рисунок 5�15. Параметры соединения

4. Нажмите Tools->Firmware loader (Рисунок 5-16).

Рисунок 5�16. Tools�>Firmware Loader
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5. Найдите папку с комплектом файлов новой версии аппаратно-программного
обеспечения. Выберите файл main.ldp (Рисунок 5-17):

Рисунок 5�17. Загрузка нового аппаратно�программного обеспечения

6. Начмите кнопку Firmware Update . 
7. После загрузки нового аппартно-программного обеспечения очистите

энергонезависимое ОЗУ (см. “Очистка энергонезависимого ОЗУ” на стр. 73) и
обновите альманах (см. “Сбор альманаха” на стр. 33).

8. Нажмите File->Disconnect, затем File->Exit, чтобы покинуть TriVU.
79www.javad.com                                                                                                                                                       



Управление приемником и файлами
Загрузка нового аппаратно�программного обеспечения
Спящий режим
80                                                                                                                     www.javad.com



Глава 6
ВЫЯВЛЕНИЕ 
НЕИСПРАВНОСТЕЙ

Эта глава поможет диагностировать и устранить неисправности и проблемы, которые
могут возникнуть при работе с приемником.
Примечание: Не предпринимайте попыток самостоятельно починить приемник. В противном случае вы

нарушаете условия гарантии и можете повредить прибор!

6.1. Проверьте в первую очередь!

Прежде, чем обратиться в службу технической поддержки компании JAVAD GNSS,
проверьте следующее:

• Внимательно проверьте внешние разъемы приемника. Проверьте, не поврежде ны
ли кабели.

• Проверьте, заряжены ли батареи, не поврежден ли кабель питания.
• проверьте, загружено ли необходимое По на компьютер, загружена ли последняя
версия аппаратно-программного обеспечения приемника. Посмотрите на сайте
компании JAVAD GNSS, нет ли новых версий.

• Если используется соединение с помощью Bluetooth®, проверьте, чтобы порт,
используемый для соединения был  в режиме Command. 

Затем, попробуйте следующее:
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• Произведите аппаратный сброс приемника, используя TriVU: Tools->Reset Receiver
(Рисунок 6-1) или с помощью MinPad (см. “MinPad” на стр. 16):

Рисунок 6�1. Tools�>Reset Receiver

• Восстановите настройки по умолчанию, используя TriVU (Configuration->Receiver,
then click Set all parameters to defaults).

• Очистите энергонезависимое ОЗУ (см. “Очистка энергонезависимого ОЗУ” на стр.
73).

Если проблема сохранила, смотрите нижеприведенные разделы, чтобы найти решение:

6.2. Проблемы питания 

Все приемники выпускаются с режимом “Auto”  для обеих батарей. Чтобы проверить эту
настройку:

1. Соедините приемник и компьютер и запустите TriVU (см. “Соединение приемника и
компьютера” на стр. 29).

2. После того, как будет установлено соединение, нажмите Configuration->Receiver. 
3. В закладке General посмотрите поля Power и Charger. Значения должны быть

установлены “Auto”. Если нет, то поставьте Auto и нажмите Apply.
Примечание: Очистка энергонезависимого ОЗУ тоже возвращает режим питания в значение Auto (см. “Очистка

энергонезависимого ОЗУ” на стр. 73).

Приемник не включается

 Батареи разряжены.
• Полностью зарядите батареи и включите еще раз. См. “Зарядка батарей” на стр. 23.

 Зарядное устройство может быть неисправным.

Если после подключения внешнего (проверенного) источника питания приемник все-таки
не работает, обратитесь в службу технической поддержки компании JAVAВ GNSS.
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6.3. Проблемы с приемником

Проблемы с кабелем

Кабель неправильно подсоединен.
• проверьте, чтобы кабель был подсоеднен к правильному разъему.
• Отсоедините кабель и посоедините его еще раз к приемнику.
• О разъемах приемника и кабелях см. “Приемник TRIUMPH-1” на стр. 15 и

“Характеристики разъемов” на стр. 96.
. Кабель поврежден.

• Используйте неповрежденный кабель. для замены кабеля обращайтесь к вашему
дилеру.

Типичные проблемы

Порт приемника, используемый для установления связи, находится не в коммандном
режиме (Command mode).
1. Соедините приемник и компьютер, как описано в “Соединение приемника и

компьютера” на стр. 29 и запустите TriVU.
2. Нажмите Configuration->Receiver->Ports.
3. Измените параметр порта, используемого для установления связи с Input  на

Command. 
Приемник долгое время не отслеживает спутники.

• У приемника старый альманах. Обновите альманах, как описано в “Сбор
альманаха” на стр. 33.

• Соответствующие опции приемника могут быть отключены или истек срок их
действия. Проверьте опции, как описывается в “Управление опциями приемника” на
стр. 70. Закажите новый файл автоизации опций. Обратитесь к вашему дилеру или
на  веб -сайт  компании  JAVAD GNSS для  получения  дополнительной
информации.Детальное описание опций вы найдете в TriVU Software Manual.

Приемник отслеживает слишком мало спутников

Значение угла возвышения слишком велико (более 15 градусов).
• Уменьшите значение угла возвышения. См. “Настройка MinPad” на стр. 50.

Съемка осуществляется в затрудненных условиях (под кронами деревьев, высокими
сроениями и т.п.).
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• проверьте,  что переключатели в закладке Multipath Reduction активированы.
• Соедините приемник и компьютер и запустите TriVU. См. “Соединение
приемника и компьютера” на стр. 29.

• Нажмите Configuration->Advanced, а затем закладку Multipath Reduction.
Активируйте оба переключателя и нажмите Apply.

• Если возможно, выйдите на открытое пространство. 

Приемник не может получить Code Differential и/или RTK решения

Введены неправильные координаты базового приемника.
• Уточните координаты базы, используя TriVU. 

Приемник не настроен как база или ровер.
• См. главу 3 о настройке приемника как базы или ровера.

Соответствующие опции приемника неактивированы или истк срок их действия.
• См. “Управление опциями приемника” на стр. 70.
• Закажите новый файл авторизации опций. Обратитесь к вашему дилеру или на веб-
с айт  компании  JAVAD GNSS для  получения  дополнительной
информации.Детальное описание опций вы найдете в TriVU Software Manual.

Недостаточно общих спутников. Чтобы получить решение, базе и роверу нужно
отслеживать, как минимум, пять общих спутников.

• Убедитесь, что база и ровер используют одинаковые обновленные альманахи. См.
“Сбор альманаха” на стр. 33.

• Проверьте значение угла возвышения для базы и ровера; он должен быть
одинаковым. Подробнее см. “Настройка MinPad” на стр. 50.

Существует несовместимость базы и ровера из-за разницы стандартов. Убедитесь, что
база и ровер используют одинаковый формат ввода/вывода поправок:
1. Соедините приемник и компьютер и запустите TriVU. См. “Соединение приемника

и компьютера” на стр. 29.
2. Откройте закладку Ports. Используйте для обоих приемников одинаковый формат

ввода/вывода поправок.
Значение угла возвышения больше 15 градусов.

• Измените значение угла возвышения.
.Низкий заряд батарей.

• Подключите к приемнику источник питания..
• Подробнее см. “Питание приемника” на стр. 28.

Радиоантенна неправильно подсоединена.
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• Проверьте, что радиоантенна правильно подсоединена.
• Проверьте, что радиоантенна не повреждена. В случае повреждения антенны
обратитесь к вашему дилеру или в компанию JAVAD GNSS для замены антенны.

Заданная скорость передачи не совместима со скоростью передачи модема.
• Измените скорость передачи на значение, коорое поддерживается модемом..

База и ровер использует различные настройки радиосоединения.
• Настройте базу и ровер, как описывается в “Настройка радиомодема” на стр. 36.

Слишком большое расстояние между базой и ровером.
• Сократите расстояние между базой и ровером.
• Используйте повторители, чтобы увеличить дальность радиопередачи.

Радиопередаче может мешать внешний источник помех.
• Смените радиоканал (если возможно).
• Используйте спектроанализатор для определения радиохарактеристик помех и
настройте свою систему в соответсвии с этими данными.

• Удалите помехи или перенаправьте вашу радиоантенну (если возможно).

Приемник не записывает данные

Опции памяти неактивированы или истек срок их действия.
• Проверьте опцию памяти. См. подробнее “Управление опциями приемника” на стр.

70.
память приемника заполнена.

• Выгрузите и/или удалите файлы данных, чтобы освободить место (см. “Выгрузка
файлов в компьютер” на стр. 65 и “Удаление файлов” на стр. 68).

• Используйте AFRM. См. “Настройка MinPad” на стр. 50 . 

6.4. Техническая поддержка

Если вы не можете самостоятельно устранить проблему, используя данные настоящего
руководства пользователя, то обращайтесь в службу тезхнической поддержки компании
JAVAD GNSS.

Прежде, чем обратиться в службу технической поддрежки по вопросу, связанному с
поблемами с приемником, прочтите раздел “Проверьте в первую очередь!” на стр. 81.
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ВыЯвление неисправностей
Техническая поддержка
E�mail
6.4.1. E�mail

Для обращения в компанию JAVAD GNSS  с помощью электронной почты используйте
следующий эелектронный адрес: support@javad.com.

Пользуйтесь также кнопкой QUESTION на веб-сайте компании www.javad.com
Примечание: Для скорейшего и успешного разрешения вашей проблемы предоставляйте наиболее полноее ее

описание.

6.4.2. Веб�сайт

На веб-сайте компании JAVAD GNSS www.javad.com имеется вся необходимая информация
о всех продуктах компаниии. В разделе технической помощи представлены все
необходимые руководства пользователя и спецификации.
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Приложение A
СПЕЦИФИКАЦИИ

Описанный продукт компании JAVAD GNSS представляет собой 216-канальный
многосистемный (GPS, Galileo и ГЛОНАСС) навигационный приемник в прочном
магниевом корпусе, с кнопками управления и индикаторами состояния (MinPad), а также с
разъемами для подключения кабелей, с опциональной съемной SIM-картой, втроенной
беспроводной технологией Bluetooth®, опциональным модемом и GSM модулем.
Примечание: Характеристики, приведенные в спецификации,  соответствуют  следующим условиям:

предполагается, что в поле зрения приемника имеется  не менее 6 GPS спутников с углом
возвышения более 15 градусов и используются процедуры, рекомендованные в Руководстве.

Примечание: При наличии сильной многолучевости, при плохом расположении спутников, когда геометрический
фактор (PDOP) имеет большую величину, а также в периоды высокой активности ионосферы
характеристики приемника могут ухудшаться.

Примечание: Используйте тщательные процедуры  проверки при наличии сильной многолучевости или при
работе под кронами деревьев.

A.1. Спецификация приемника

A.1.1. Основные  характеристики

В таблице ниже приведены .

Таблица 1. Основные характеристики приемника| 

Физические

Корпус Магниевый сплав и пластик, водонепроницаемый 
Цвет JAVAD GNSS Зеленый и Серый
Размеры 178 мм x 96 мм x 178 мм
Вес 1.700 кг
Антенна Встроенная
Батареи Две встроенных
Контроллер Внешний (продается отдельно)
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Спецификации
Спецификация приемника
Основные характеристики
Резьба крепления 5/8-11
Уплотнение Силикон
Кнопки Две кнопки:

Включения/Выключения
Function (FN) – начало/конец записи данных, переключение 
информационных режимов.

Светоизлучающие диоды 
(СИД)

Шесть СИДов:
SAT – статус приемника и спутников
REC – статус записи данных
BAT – статус батарей
MOD – статус модема
BT - статус модуля Bluetooth® 
POS - статус полученного решения

Окружающая среда

Тепрература работы -40 C° до + 55 C° с батареями
Температура хранения -40 C° до +55 C° с батареями
Влажность 95% неконденсирующаяся

Питание

Встроенные батареи Li-Ion, 4400 mAh, 7.4 B
Размер батарей 133 мм x 38мм x 20 мм
Вес батарей 190 г (1 батарея)
Количество встроенных 
батарей

2 батареи

Время работы Не менее 15 часов
Входное напряжение +10 до +30 B постоянного тока (для работы)

+10 до +30 В постоянного тока (для зарядки батарей)
Встроенная батарея Обеспечивает работу внутренних часов и сохранение альманаха при 

выключении питания. Рассчитана на работу в течение 10 лет.

Внешний источник питания

Разъем 1 
Входное напряжение +10 до +30 B постоянного тока 

Ввод/вывод

Коммуникационные порты - 2 последовательных (RS232) до 460.8 kbps
- Высокоскоростной USB 2.0 (480 Mbps)
- Full-duplex 10BASE-T/100BASE-TX Ethernet
- Wi-Fi (IEEE 802.11b/g)
- Bluetooth® V2.0+EDR Class 2 поддерживающий SPP Slave и Master 
Profiles 
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Спецификации
Спецификация приемника
Основные характеристики
Разъемы - внешний для ГНСС антенны (опционально)
- для модемной антенны
- для внешнего источника питания (PWR)
- 1PPS вывод (опционально)
- Event Marker ввод (опционально)

MinPad - Шесть СИДов (SAT, REC, BAT, MOD, BT, POS)
- Две кнопки (Вкл/Выкл, FN)

Функциональные возможности

До 100 Гц uЧастота выдачи измеренных координат и сырых данных в реальном времени
10 см точность измерения кодовой задержки; 1 мм точность измерения фазы несущей
Декодер Витерби
Поддержка стандартов
RTCM SC104 версии 2.x и 3.x ввод/вывод
NMEA 0183 версии 2.x и 3.0 вывод
Multi-Base Code Differential Rover
Code Differential Base
Модели геоидов и магнитных отклонений
RAIM
Поддержка различных систем базовых геодезических параметров (DATUM)
Вывод прямоугольных координат

Технологии

Режим совместного слежения за сигналами нескольких спутников 
Захват слабого сигнала 
Режим подавления многолучевости 
Использование сигналов широкозонных систем спутниковой дифференциальной навигации (SBAS)
Регулируемые параметры систем слежения за задержкой (DLL) и слежения за несущей (PLL)

NMEA

NMEA Вер. 2.1, 2.2, 2.3, 3.0 
Сообщения GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC, VTG, ZDA, ROT, 

GMP
Интервал выдачи 1Гц стандартно; 5, 10, 20, 50, 100 Гц опционально

Кодовый дифференциальный режим местоопределения (DGPS)

Формат поправок RTCM SC104  
Вер. 2.1, 2.2, 2.3, и 3.0

RTCM 2.x тип сообщений 1, 3, 9, 31, 32, 34; задается пользователем
RTCM 3.0 тип сообщений 1003, 1004, 1005, 1006, 1007, 1008, 1011, 1012, 1019, 1020; user selectable
Интервал обработки 1Гц стандартно; 5, 10, 20 Гц опционально
Интервал выдачи RTCM 
поправок 

1Гц стандартно; 5, 10, 20 Гц опционально

Угол возвышения 0 до 90 градусов (независимо от записи данных)
Multi-base DGPS Режимы: Nearest, Mix, Best (опционально)
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Спецификации
Спецификация приемника
Основные характеристики
Фазовый дифференциальный режим местоопределения подвижных обьектов 
в режиме реального времени (RTK)

Формат поправок CMR2/CMR+ (совместимо с Trimble), 
RTCM SC104 версии 2.2, 2.3 или 3.0

Тип сообщений 
RTCM 2.x 

3, 18, 19, 20, 21, 22; задается пользователем

Тип сообщений 
RTCM 3.0 

1003, 1004, 1005, 1006, 1007, 1008, 1019, 1011, 1012, 1020; задается 
пользователем 

Инициализация 
неоднозначности (Ambiguity 
initialize)

OTF (L1, L1/L2)

Длина базовой линии До 50 км утром и вечером 
До 32 км в полдень

Время инициализации От 5 сек. до 10 мин. в зависимости от длины баловой линии и условий 
многолучевости

Формат поправок RTCM SC104 версии 2.2, 2.3 или 3.0
Возвышение От 0 до 90 градусов (независимо от записи данных)
Способ использования 
дифпоправок

с задержкой (синхронный)
с экстраполяцией (асинхронный)

Интервал обработки 1Гц обычно; 5, 10, 20Гц опционально
Запаздывание С задержкой - 20 мс ...20 с (зависит от задержек при передаче дифпоправок 

от базового приемника).
С экстраполяцией - 20 ... 30 мс

Запись сырых данных В режиме RTK приемник может записывать сырые данные с другим 
интервалом

Статус “Фиксированное” решение (Fix), “плавающее” решение (Float),  
Геометрический фактор (GDOP), Состояние линии передачи данных (Data 
Link Status), Запаздывание (Modem Latency), Общие спутники (Common 
Satellites), Процент фиксированных решений (Percentage of fixing)

Результаты RTK координаты, разброс по горизонтали (HRMS),
Разброс по вертикали (VRMS), 
Матрица ковариаций (Covariance Matrix)

Вероятность правильной 
фиксации неопределенности

Выбираемый порог:
Низкий (Low): 95%
Средний (Medium): 99,5%
Высокий (High): 99,9%

Типы съемки

База или Ровер Статическая съемка (Static)
Быстрая статическая съемка (Fast Static)
Кинематическая  съемка (Kinematic: Stop and Go)
Кинематическая съемка врежиме реального времени (RTK)
Съемка с использованием кодовых поправок (DGPS)
Съемка с использованием поправок от спутниковых систем  (SBAS DGPS)
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Спецификации
Спецификация приемника
Основные характеристики
Точность съемки

Статика, Быстрая статика По горизонтали: 0.3 см + 0.5 ppm * длина_базовой_линии
По вертикали: 0.5 см + 0.5 ppm * длина_базовой_линии

Kinematic, RTK По горизонтали: 1 см + 1 ppm * длина_базовой_линии
По вертикали: 1.5 см + 1.5 ppm * длина_базовой_линии

RTK (OTF) По горизонтали: 1см + 1 ppm * длина_базовой_линии
По вертикали: 1.5 см + 1.5 ppm * длина_базовой_линии

DGPS < 0.25 м Post Processing,
< 0.5 м  Real Time

Холодный старт 
Горячий стартt
Повторный старт 
(Reacquisition)

< 35 сек
< 5 сек

< 1 сек
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Спецификации
Спецификация приемника
Характеристики ГНСС платы
A.1.2. Характеристики ГНСС платы

В таблице ниже представлены основные характеристики ГНСС платы приемника.

Таблица 2. Характеристики ГНСС платы

Тип приемника

TRIUMPH-1-G2T 

TRIUMPH-1-G3T 

GPS L1/L2/L2C/L5
Galileo E1/E5A
GPS L1/L2/L2C/L5
Galileo E1/E5A
ГЛОНАСС L1/L2

Характеристики слежения

Стандартные каналы Всего 216 каналов: all-in-view (GPS L1/L2/L2C/L5,
Galileo E1/E5A, ГЛОНАСС L1/L2, SBAS)

Отслеживаемые каналы L1/L2 C/A и P-код и несущая,

Функции слежения

Подавление многолучевости По коду и по несущей
Установки петель PLL/DLL Полоса, порядок, возможность регулировки
WAAS/EGNOS WAAS опционально; EGNOS опционально

Память

Внутренняя память До 2048Мб 
Запись сырых данных до 100 раз в сек (100Гц)
Тип данных GPS L1, L2, Galileo E1/E5A, ГЛОНАСС L1/L2 (толькоG3T) фаза и несущая

PPS вывод (опционально)

Количество PPS портов 1
Используемый фронт Нарастающий, падающий (Rise, Fall)
Период От 10 до 1000000000 мс
Смещение От -500000000 до 500000000 мс
Опорное время GPS, GLONASS, 

UTC (USNO), 
UTC (SU)

Маркер событий (опционально)

Колическтво поротов для 
маркера событий

1

Используемый фронт Нарастающий, падающий (Rise, Fall)
Опорное время GPS, GLONASS, UTC (USNO), UTC (SU)
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Спецификации
Спецификация приемника

Характеристики Bluetooth®�модуля
A.1.3. Характеристики Bluetooth®�модуля

В таблице ниже предтавлены основные характеристики модуля беспроводной технологии
Bluetooth®.

Таблица 3. Основные характеристки Bluetooth®�модуля

A.1.4. Встроенный УВЧ радиомодем

В таблице ниже приведены основные характеристики встроенного УВЧ  радиомодемы
Таблица 4. Характеристики встроенного УВЧ радиомодема

Тип Класс 2
Дальность до 10 м (в помещении)

до 50 м (вне помощения)
Типы служб Смешанные
Поддерживаемые профили LM, L2CAP, SDP, PPP
Региональные коды частоты Северная Америка и Европа

Радиопередатчик

Частотный диапазон 403 - 470 МГц (CША)
403-430 МГц; 440-470 МГц (Канада)

Разнос каналов 25/12.5/6.25 кГц

Стабильность несущей частоты ±1 ppm, соответствует FCC 2.1055, 90.213

Тип модуляции GMSK/DBPSK/DQPSK/D8PSK/D16QAM 

Режим связи Half duplex, simplex

Передатчик

Выходная мощность передатчика +15... +30 dBm  1 dB шаг / 50 Ω
Соответствует FCC 2.1046

Стабильность несущей частоты +1 dB / -2 dB

Занятая ширина полосы Соответствует FCC 2.1049, 90.209

ЭМИ маска Соответствует FCC 90.210

Внеполосное излучение Соответствует FCC 2.1053, 90.210
93www.javad.com                                                                                                                                                       



Спецификации
Спецификация приемника
Встроенный УВЧ радиомодем
Приемник

Чувствительность приемника при 
DBPSK (@ BER 1x 10-4, при 
температуре -30 oC до +50 oC)

-113 dBm for 25 кГц разнос каналов,
-114 dBm for 12.5 кГц разнос каналов,
-114 dBm for 6.25 кГц разнос каналов

Чувствительность приемника при  
DQPSK (@ BER 1x 10-4, o при 
температуре -30 oC to +50 oC)

-110 dBm for 25 кГц разнос каналов
-111 dBm for 12.5 кГц разнос каналов
-111 dBm for 6.25 кГц разнос каналов

Динамический диапазон -119 до -52 dBm

Избирательность по соседнему 
каналу

70 dB для 25 кГц разнос каналов
60 dB для 12.5 кГц разнос каналов
50 dB для 6.25 кГц разнос каналов

Модем

Интерфейс DSP UART (последовательный порт)

Разъем интерфейса 16-lead разъем

Скорость данных 9600 - 115200 bps

Скорость передачи данных
(25 кГц разнос каналов)

9600 bps – DBPSK/GMSK
19200 bps – DQPSK
28800 bps – D8PSK
38400 bps – D16QAM

Скорость передачи данных
(12.5 кГц разнос каналов)

4800 bps – DBPSK/GMSK
9600 bps – DQPSK
14400 bps – D8PSK
19200 bps – D16QAM

Скорость передачи данных
(6.25 кГц разнос каналов)

2400 bps – DBPSK
4800 bps – DQPSK
7200 bps – D8PSK
9600 bps – D16QAM

Помехо-устойчивое кодирование  
(FEC) 

Reed-Solomon Error Correction

Сремблирование Да
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Спецификации
Спецификация приемника

Встроенный УВЧ радиомодем
Характеристики опционального GSM модуля

В таблице ниже приведены основные характеристики опционального GSM-модуля.

Таблица 5. Характеристики GSM�модуля

Операционная система 850/900/1800/1900 МГц

Функционирующие системы EGSM: 900/1800 MГц
GSM 850/1900 MГц

RX чувствительность -106dBm (4dB margin on top of spec)

Мощность передатчика Класс 4 - 2 Ватт (850/900 MГц);
Класс 1 - 1 Ватт (1800/1900 MГц)

GPRS Multi-slot class 10 (4 down; 2 up; 5 Total)
Max BR 85.6 Kbps
Class B GSM 07.10 multiplexing protocol
Coding scheme CS1-CS4
Embedded TCP/IP and UDP/IP protocol stack
Embedded FTP
Embedded SMTP/POP3 – e-mail
SSL – Secure Connection

CSD Max BR 14.4 Kбит/сек

EDGE – зависит от модели Multi-slot class 10 (4 Down; 2 Up; 5 Total)
Max BR Downlink 236.8 Kbps (Over RS232)
Coding Scheme MCS1-MCS9

SMS Режимы MO/ MT Text и PDU;
Cell broadcast.

One serial port Data and Command port

UART BR from 300 bps to 460 Kbps, Auto BR

SIM-Карта Поддержка 2 SIM-карт; 3.0 V, STK 3.1

Разъем RF MMCX

Сертификация FCC, IC, CCC
FTA, PTCRB
R&TTE
GCF
EMC
QS9000 manufacturing
RoHS/WEEE
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Спецификации
Характеристики разъемов
Встроенный УВЧ радиомодем
A.2. Характеристики разъемов 

Разъем питания

Разъем питания (Рисунок A-1) - это герметичная 5-ти штырьковая розетка типа ODU p/n
G80F1C-T05QF00-0000.

Рисунок A�1. Разъем питания

Таблица 6. Характеристики разъема питания

Номер Наименование сигнала Dir Пояснение

1 Power_INP P От 10 до 30 В постоянного тока ввод
2 Power_INP P От 10 до 30 В постоянного тока ввод
3 Power_GND P Земля, power return
4 Power_GND P Земля, power return
5 Не используется
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Спецификации
Характеристики разъемов

Встроенный УВЧ радиомодем
Разъем RS�232C 

Разъем RS232С (Рисунок A-2) - это герметичная 7-ми штырьковая розетка типа ODU p/n
G80F1C-T07QC00-0000.

Рисунок A�2. RS�232C разъем

Таблица 7. Характеристики RS�232C разъема

Номер Наименование сигнала Dir Пояснение

1 Power_OUT P Power Output (supplied voltage)
2 GND - Земля
3 CTS I Clear to send
4 RTS O Request to send
5 RXD I Прием данных
6 TXD O Передача данных
7 Не используется
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Спецификации
Характеристики разъемов
Встроенный УВЧ радиомодем
USB� разъем

USB-разъем, это это герметичная 5-ти штырьковая розетка типа ODU, p/n G80F1C-T05QF00-
0000 (Рисунок A-3).

Рисунок A�3. USB�разъем

Таблица 8. Характеристики USB�разъема 

Номер Наименование сигнала Dir Пояснение

1 Не используется
2 USB_PWR P Bus power
3 GND - Земля
4 USB D+ I/O Data plus
5 USB D- I/O Data minus
98                                                                                                                     www.javad.com



Спецификации
Характеристики разъемов

Встроенный УВЧ радиомодем
Ethernet � разъем

Etherne-разъем это герметичная 7-ми штырьковая розетка типа ODU p/n G80F2C-P07QC00-
0000 (Рисунок A-4).

Рисунок A�4. Ethernet�разъем

Таблица 9. Характеристики Ethernet�разъема

Разъем для внешней ГНСС антенны (опционально)

Разъем для внешней антенны (Табл. 10) это TNC RF разъем Applied Engineering Product p/n
6001-7051-003.

Таблица 10. GNSS External Antenna RF Connector

Номер Наименование сигнала Dir Пояснение

1 Not used

2 Power_GND Signal ground

3 TXD+ O Transmit data plus

4 TXD- O Transmit data minus

5 RXD+ I Receive datd plus

6 RXD- I Receive data minus

7 LAN LED External LAN LED anode

Номер Наименование сигнала Dir Пояснение

TNC ANT_IN I RF input from LNA, 100 mA at 5.0 volts DC output
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Спецификации
Характеристики разъемов
Встроенный УВЧ радиомодем
Разъемы EVENT и 1PPS  (опционально)

Разъемы EVENT и 1PPS - это коаксиальные с внутренней резьбой розетки серии BNC,
Kings Electronics p/n KC-79-108.
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Приложение B
ИСПОЛЬЗОВАНИЕ УВЧ 
РАДИО

Во многих странах требуется специальная лицензия для пользования радио. Прежде, чем
использовать радиопередатчик,  убедитесь, что ваше использование радиопередатчика
соответствует местным законам.

Съемка в режиме RTK сделала очень популярным использование УВЧ модемов для
коммуникации между базовым и подвижными приемниками.  Ознакомьтесь со всеми
недостатками и преимуществами данной технологии, чтобы добиться лучшего результата
при съемке.

Дальность сигнала очень зависит от местных условий. Географические особености
местности, местные системы связи и, конечно, метеорологические условия играют
большую роль в определении возможной дальности RTK связи.

При необходимости используйте сканер для обнаружения свободных частот для
установления связи.
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Приложение C
ТЕХНИКА БЕЗОПАСНОСТИ

C.1. Основные положения

Примечание: Следуя требованиям по использованию радиооборудования, сохраняйте не менее координатб
между пользователем и GSM/GPRS модемом/УВЧ модемом.

Внимание: Приемник TRIUMPH-1 предназначен для использование его для геодезической съемки и
связанными с ней мероприятиями (т.е.,  съемка координат, расстояния, углов и т.п и для
записи этих данных).  Этот приемник не может быть использован:
– прежде, чем пользователь ознакомится с данным руководством.
– с неавторизованными (не фирменными) аксессуарами.
– без должного соблюдения техники безопасности во время съемки.
– с наружением законов, правил и норм.

ОСТОРОЖНО! TRIUMPH-1 никогда не должен использоваться  на опасных участках. В снежную и
дождливую погоду используйте прибор ограниченное время..

C.2. Использование

Если этот продукт падал, был изменен, транспортировался без надлежащей упаковки, то он
мог быть серьезно поврежден.
ОСТОРОЖНО! Не подключайте и не отсоединяйте оборудование влажными (мокрыми) руками. Вы

подвергаете себя  риску поражения  электрическим током!

Если данный продукт не работет или работает не правильно, незамедлительно сообщите об
этом компании JAVAD GNSS.

Только авторизованные гарантийные сервисы имеют право обслуживать и ремонтировать
данный продукт.
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Использование
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Приложение D
ГАРАНТИЙНЫЕ 
ОБЯЗАТЕЛЬСТВА

Настоящая  гарантия распространяется на приемник TRIUMPH-1. Компания JAVAD GNSS
настоящим  гарантирует,  что  продукт  TRIUMPH-1 (“Продукт”) на  момент  его
первоначальной продажи не имеет дефектов материалов, конструкции или сборки при
соблюдении следующих условий:

1. Настоящая ограниченная гарантия предоставляется конечному покупателю
Продукта («Потребителю»). Данная гарантия не отменяет и не ограничивает (1)
установленных законом неотъемлемых прав Потребителя или (2) каких-либо прав
Потребителя в отношении продавцов/распространителей Продукта.

2. Гарантийный период указан в гарантийной карте, прилагаемой к Продукту..
3. В течение гарантийного периода компания JAVAD GNSS или ее авторизированные

сервисные компании обязуются заменить или отремонтировать, по усмотрению
компании, неисправный Продукт. JAVAD GNSS обязуется передать Потребителю
отремонтированный или иной Продукт в хорошем рабочем состоянии. Все детали
или иное замененное оборудование являются собственностью компании JAVAD
GNSS.

4. Гарантийный период на отремонтированный или замененный Продукт не
продлевается и не возобновляется.

5. Настоящая гарантия не распространяется на дефекты, вызванные нормальным
износом. Данная гарантия также не применяется в следующих случаях:
1)Дефект возник в результате использования с нарушением правил, установленных
инструкцией по эксплуатации; ненадлежащего ухода; воздействия влаги,
эксплуатации в условиях повышенной влажности, высоких и низких температур,
других экстремальных условиях окружающей среды или при их резком изменении;
коррозии, окисления, несанкционированного изменения или подсоединения;
несанкционированного вскрытия или ремонта; ремонта с использованием
неразрешенных запасных частей; неправильного использования; ненадлежащей
инсталляции; повреждений, вызванных несчастными случаями, природными
воздействиями, попаданием пищи или жидкости, воздействием химических
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Гарантийные обЯзательства
продуктов и иных действий, находящихся вне разумного контроля (включая, но не
ограничиваясь дефектами расходных частей, таких как батареи, которые по своей
природе имеют ограниченный срок службы, а также поломкой или повреждением
антенн) в случаях, когда такие дефекты прямо не вызваны дефектами материалов,
конструкции или сборки.
2) Потребитель не уведомил компанию JAVAD GNSS  либо ее уполномоченную
сервисную компанию о наличии дефекта в течение 30 (тридцати) дней после
возникновения дефекта во время гарантийного периода.
3)Продукт не был возвращен компании JAVAD GNSS или ее уполномоченной
сервисной компании в течение 30 (тридцати) дней после возникновения дефекта во
время гарантийного периода.
4) Серийный номер Продукта, его идентификационный номер (ID), были удалены,
стерты, испорчены, изменены или являются нечитаемыми.
5) Дефект был вызван тем, что Продукт эксплуатировался с использованием или
был подсоединен к аксессуарам, не производящимся ни не поставляемым
компанией JAVAD GNSS, или использовался в иных, не предназначенных для этого,
целях.
6) Дефект был вызван коротким замыканием батарей, были нарушены пломбы
корпуса или ячеек батарей, или существуют доказательства того, что были внесены
изменения в схему батарей, или батареи использовались в оборудовании, для
которого они не были предназначены.

6. Для того, чтобы воспользоваться настоящей гарантией Потребитель должен
представить либо (1) удобочитаемый и не содержащий поправок оригинал
гарантийного талона с указанием наименования и адреса продавца, даты и места
покупки, типа продукта, ID номера, либо (2) удобочитаемый и не содержащий
поправок оригинал товарного чека с указанием той же информации, если указанный
товарный чек предоставляется продавцу/распространителю Продукта.

7. Настоящая гарантия является единственным и исключительным средством защиты
Потребителя в отношении компании JAVAD GNSS и составляет единственное и
исключительное обязательство JACAD GNSS случае обнаружения неисправностей
или ненадлежащей работы Продукта. Настоящая гарантия заменяет собой все
другие гарантии и обязательства, как письменные, так и устные, предусмотренные
законом, контрактом, возникшие в результате гражданского иска и иные. JAVAD
GNSS в любом случае не несет ответственности за какие-либо побочные, случайные
или косвенные убытки, ущерб или расходы. JAVAD GNSS  также не несет
ответственности за прямые убытки, ущерб или расходы в случае, если Потребитель
является юридическим лицом. 
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8. Любые изменения и дополнения к настоящей ограниченной гарантии могут быть
сделаны только с предварительного письменного разрешения компании JAVAD
GNSS.
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